If you are not using Excel 2007 you need a different book

This book is for Excel 2007 users. If you have a different version of Excel you can download the correct
version of this book at the ExcelCentral.com web site. Here are the direct links: Excel 2010, Excel 2013, Excel
2016.

Make sure you are using the latest version of this free e-book

This Excel 2007 book was last revised on 21t September 2017. You can always download the most recent
version of this book completely free of charge from: http://ExcelCentral.com.

Why you should use this free e-book

Learning success is guaranteed. For over fifteen years, Smart Method® classroom courses have been
used by large corporations, government departments and the armed forces to train their employees.
This book has been constantly refined (during hundreds of classroom courses) by observing which skills
students find difficult to understand and then developing simpler ways of explaining them. This has
made the book effective for students of all ages and abilities. We have never had a student who has
failed to learn Excel after taking one of our courses.

It is the preferred choice for teachers. As well as catering for those wishing to learn Excel by self-study,
Smart Method® books have long been the preferred choice for Excel teachers as they are designed to
teach Excel and not as reference books. Books follow best-practice adult teaching methodology with
clearly defined objectives for each learning session and an exercise to confirm skills transfer. With single,
self-contained lessons the books cater for any teaching period (from minutes to hours).

It is free (and you can print it). Because this book is free of charge, schools, colleges, universities and
businesses are able teach their students best-practice Excel skills without the substantial cost of
designing lesson plans or purchasing books. If printed copies are needed you can print them yourself, or
any copy shop can print books for you.

Smart Method books are #1 best sellers. While this book is entirely free of charge, every paper printed
Smart Method® Excel book (and there have been nine of them starting with Excel 2007) has been an
Amazon #1 best seller in its category. This provides you with the confidence that you are using a best-of-
breed resource to learn Excel.

No previous exposure to Excel is assumed. You will repeatedly hear the same criticism of most Excel
books: “you have to already know Excel to understand the book”. This book is different. If you've never
seen Excel before, and your only computer skill is using a web browser, you'll have absolutely no
problems working through the lessons. No previous exposure to Excel is assumed and everything is
explained clearly and in a simple way that absolutely any student, of any age or ability, can easily
understand.

It focuses upon the everyday Excel skills used in the workplace. This free Basic Skills book will teach
you the basics without confusing you with more advanced, less used, Excel features. If you decide to
expand your Excel education you'll be able to move on to other Smart Method® books (or e-books) in
this series to master even the most advanced Excel features.

Basic Skills books are available for every Excel version in common use. You are reading this book
because you are using Excel 2010. You're probably aware that Excel is now available in a new Excel 2016
version (sometimes also called Excel 365). Our free Basic Skills courses are available (for download from
ExcelCentral.com) for Excel 2007, 2010, 2013, 2016 and Excel 2016 for the Apple Mac.

This is the world’s only Excel course that is available in both book and video form. Each can be used as a
stand-alone resource, but together they provide an incredibly powerful learning experience.


http://excelcentral.com/excel2010/basic/tutorials/default.html
http://excelcentral.com/excel2013/basic/tutorials/default.html
http://excelcentral.com/excel2016/basic/tutorials/default.html
http://excelcentral.com/excel2016/basic/tutorials/default.html
http://excelcentral.com/

Learn Excel in just a few minutes each day (or in one five-hour sitting)

Excel is a huge and daunting application and you'll need to invest some time in learning the skills presented
in this book. This will be time well spent as you’ll have a hugely marketable skill for life. With 1.2 billion
users worldwide, it is hard to imagine any non-manual occupation today that doesn’t require Excel skills.

This book makes it easy to learn at your own pace because of its unique presentational style. The book
contains 41 self-contained lessons and each lesson only takes a few minutes to complete.

You can complete as many, or as few, lessons as you have the time and energy for each day. Many learners
have developed Excel skills by setting aside just a few minutes each day to complete a single lesson. Others
have worked through the entire book in less than five hours.

Hardly anybody understands how to use every Excel feature

It is important to realize that Excel is probably the largest and most complex software application ever
created. Hardly anybody understands how to use every Excel feature and, for almost all business users, large
parts of Excel’s functionality wouldn’t even be useful.

Many learners make the fundamental error of trying to learn from an Excel reference book that attempts to
document (though not teach) everything that Excel can do. Of course, no single book could ever actually do
this. (There are some advanced Excel features that easily justify an entire book of their own).

This free Basic Skills book will teach you the basic Excel skills that are used every day, in offices all over the
world. The book’s objective is to teach the basics without confusing you by including more advanced, less
used, Excel features.

By the end of this free Basic Skills book you’'ll be completely comfortable creating your own formulas using
functions from Excel’s vast function library. You'll also have mastered fundamental Excel skills such as
AutoSum, AutoFill and Formula Autocomplete. You'll be confident in the knowledge that you are using Excel’s
features in the correct, best-practice, professional way and you'll feel really at home with Excel.

If you decide to expand your Excel education you’ll be able to use other books in this series to master even
the most advanced Excel features.
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The full course outlines for Essential Skills and Expert Skills can be viewed at the http://ExcelCentral.com
web site and in the appendix at the back of this book.
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Introduction

Who is this book for?
This book is for Excel 2007 users who:

B Need to acquire basic Excel skills quickly.
B Have never used Excel before.

This Basic Skills book (along with the accompanying online video tutorials available at ExcelCentral.com)
provide a 100% effective (and completely free) way for new learners to acquire basic Excel skills with little or
no past exposure to Excel.

This book is only suitable for learning Excel 2007 for Windows

This book is written purely for Excel 2007. If you are using Excel 2010, Excel 2013 or Excel 2016 you should
download the matching version of this book from the http://ExcelCentral.com website. Here are the direct
links: Excel 2010, Excel 2013, Excel 2016.

If you have an Apple Mac you need our Apple Mac basic skills book

This book isn't suitable for the Apple Mac versions of Excel.

The Mac versions of Excel have a reduced feature set and a radically different user interface to the Windows
versions.

We don’t publish a book for older versions of Excel for Mac but we do have a free Excel for Mac Basic Skills
version for Excel 2016. You can download: Learn Excel 2016 Basic Skills for Mac OS X with The Smart Method
free from the http://ExcelCentral.com web site.
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Excel competence levels

Office workers who use Excel every day for a living generally only use (and only need) a tiny fraction of
Excel's enormous feature set.

Excel is a huge application with thousands of features. For most users it is a mistake to attempt to learn
every Excel feature but, instead, to learn Excel to a competence level that is appropriate for your needs.
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Basic Skills

This is where you will be at the end of this book. You'll feel really comfortable with Excel. Even at Basic
Skills level you'll have mastered many skills that most untrained Excel users are unable to use correctly.
You'll also be using the correct professional techniques rather than “muddling though” in the way that most
self-taught Excel users do. You'll be able to create your own formulas using functions from Excel’s vast
function library and have a complete mastery of fundamental Excel features such as AutoFill and Formula
Autocomplete.

Essential Skills

At this level you will have excellent Excel skills, good enough to impress any employer, and your Excel skills
will be better than most office workers (even those with many years of experience). You'll be able to create
beautifully laid-out worksheets that will really impress. You’'ll also have mastered many advanced features
that few Excel users understand such as absolute and relative cell references, visualizations, advanced charts,
conditional formatting, date serial numbers and themes. You can see a full list of the lessons in the Essential Skills
course at the back of this book in: Appendix A: Skills Covered in the follow-on Essential Skills Course.

Expert Skills

At Essential Skills level you'll be really, really good with Excel. If you want to join the tiny elite of power-
users who can do absolutely everything with Excel you can move to expert level and become a true Excel
guru.

This is a extremely high level of Excel competence that is very rarely found in the workplace (even amongst
top professionals). Your Excel skills will be greater and broader than almost all other Excel users and you
will understand (and be able to use) absolutely every Excel feature. You'll have a complete mastery of skills
that are often even a mystery to Excel power users such as solver, forms, what-if analysis, pivot tables and
macros. You can see a full list of the lessons in the Expert Skills course in: Appendix B: Skills Covered in the
follow-on Expert Skills Course.



We encourage you to print this free book

Unlike most e-books, this one isn’t locked to prevent printing (this is also true for all other Smart Method e-
Books provided they are obtained from http://ExcelCentral.com).

For classroom use we recommend that you print this book

While this book is ideal for self-instruction, it is also ideal for teaching structured, objective-led, and highly
effective classroom courses. Even though you can read this book on an iPad, personal computer or e-Book
reader, some students find it easier to use if you print it onto paper. You may legally print copies of this
book (for yourself or your students) with only two conditions:

1. You must print the book exactly as it is published and may not add or remove any book content or
copyright notices.

2. You may not make any charge for the books that you print. It is permissible, however, to give free copies
of the book to students who attend a free (or paid for) class or course.

For classroom courses you can obtain a professional-looking result by printing (double-sided). You can then
punch the pages and place them into a four-hole binder. Make sure that odd pages appear on the right-hand
side. This enables each two-page lesson to be viewed without turning the page.

For a professional touch you can also put a color insert onto the front cover. Here’s how it then looks:

Learn

Excel 2007
Basic Skills

With The Smart Method

You can download the two files you need from: http://ExcelCentral.com/print

A copy shop will print this book for you for around $6

As a guide, Staples have 1500 stores in North America. On 12th August 2017, their website quoted the
following (one book) print price for this book:

Printed in Black and White (without color cover sheet) $6.19
Printed in Black and White with booklet binding $6.78
Color cover sheet (if required) $1.00

It is likely that most smaller copy shops would charge around the same.

If you in North America or Canada we can supply 5+ printed books at
our true cost price

Our cost of printing this book (printing, delivery and sales tax) for perfect-bound books (glossy colour cover
with black & white inner) is currently a little under four dollars. You can see the current price at:
http://excelcentral.com/discounts/wholesale.aspx. We can’t supply single copies as the delivery cost for one

book would make it as expensive as printing yourself at a copy shop.
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Support, Feedback and Sample Files

Welcome to Learn Excel 2007 Basic Skills With The Smart Method®. This book has been designed to enable
students to master Excel 2007 by self-study. The book is equally useful as courseware in order to deliver
courses using The Smart Method® teaching system.

Smart Method publications are continually evolving as we discover better ways of explaining or teaching the
concepts presented.

Feedback

At The Smart Method® we love feedback — both positive and negative. If you have any suggestions for
improvements to future versions of this book, or if you find content or typographical errors, the author
would always love to hear from you.

You can make suggestions for improvements to this book using the online form at:

http://ExcelCentral.com/support

Future editions of this book will always incorporate your feedback so that there are never any known errors
at time of publication.

If you have any difficulty understanding or completing a lesson, or if you feel that anything could have been
more clearly explained, we’d also love to hear from you. We’ve made hundreds of detail improvements to
our books based upon reader’s feedback and continue to chase the impossible goal of 100% perfection.

Downloading the sample files

In order to use this book it is sometimes necessary to download sample files from the Internet. The sample
files are available from:

http://ExcelCentral.com

Type the above URL into your web browser and you'll see the link to the sample files at the top of the home
page.

Problem resolution

If you encounter any problem using the course or downloading the sample files you can contact us using the
online form at:

http://ExcelCentral.com/support

We’ll do everything possible to quickly resolve the problem.


http://excelcentral.com/support
http://excelcentral.com/
http://excelcentral.com/support

Typographical Conventions Used In This

Book

This guide consistently uses typographical conventions to differentiate parts of the text.

When you see this

Here’s what it means

This edition was written using Microsoft Excel
2007 Service Pack 1 running under the Microsoft
Vista Service Pack 1 operating system

Click the Windows Start Button @ at the
bottom left of your screen.

Italics may sometimes be used for emphasis or
distinction.

Italics are sometimes also used when you need
to click on a control.

Click: Home—~>Font->Underline.

Calibri 111

Click on the Ribbon’s Home tab and then look
for the Font group. Click the Underline button
within this group (that’s the left-hand side of
the button, not the drop-down arrow next to
it).

Don’t worry if this doesn’t make sense yet. We
cover the Ribbon in depth in session one.

Click: Home->Font->
Underline Drop Down->Double Underline.

I/\‘i)__lnu:j'zrlinnz

D Double Underline

=

Click on the Ribbon’s Home tab and then look
for the Font group. Click the drop-down arrow
next to the Underline button (that’s the right-
hand side of the button) within this group and
then choose Double Underline from the drop-
down list.

Click Office->Excel Options—>
Popular->Edit Custom Lists->Import

©3) Office Button

This is a more involved example. The Office
Button is at the top left hand corner of the
Excel screen.

1. Click the Office Button, and then click the
Excel Options button.

A new dialog pops up.

2. Choose the Popular list item and then
click the Edit Custom Lists button.

Yet another new dialog pops up.

3. Click the Import button.

Type European Sales into the cell.

Whenever you are supposed to actually type
something on the keyboard it is shown in bold
faced text.

Press <Ctrl> + <Z>.

You should hold down the Ctrl key and then
press the Z key.



| AutoSum |

When a lesson tells you to click a button, an
image of the relevant button will often be
shown either in the page margin or within the
text itself.

note

In Excel 2007 there are a
possible 16,585 columns and
1,048,476 rows. This is a great
improvement on previous
versions.

If you want to read through the book as
quickly as possible, you don’t have to read
notes.

Notes usually expand a little on the
information given in the lesson text.

important

Do not click the Delete button
at this point as to do so would
erase the entire table.

Whenever something can easily go wrong, or
when the subject text is particularly important,
you will see the important sidebar.

You should always read important sidebars.

tip
Moving between tabs
using the keyboard

You can also use the
<Ctrl>+<PgUp> and
<Ctrl>+<PgDn> keyboard
shortcuts to cycle through all of
the tabs in your workbook.

Tips add to the lesson text by showing you
shortcuts or time-saving techniques relevant
to the lesson.

The bold text at the top of the tip box enables
you to establish whether the tip is appropriate
to your needs without reading all of the text.

In this example you may not be interested in
keyboard shortcuts so do not need to read
further.

anecdote

I ran an Excel course for a small
company in London a couple of
years ago...

Sometimes I add an anecdote gathered over
the years from my Excel classes or from other
areas of life.

If you simply want to learn Excel as quickly as
possible you can ignore my anecdotes.

trivia

The feature that Excel uses to
help you out with function calls
first made an appearance in
Visual Basic 5 back in 1996 and
had the wonderful name:
IntelliSense. The Excel...

Sometimes I indulge myself by adding a little
piece of trivia in the context of the skill being
taught.

Just like my anecdotes you can ignore these if
you want to. They won’t help you to learn
Excel any better!

The World’s Fastest
Cars

When there is a sample file (or files) to
accompany a lesson, the file name will be
shown in a folder icon. You can download the
sample file from: www.ExcelCentrall.com.
Detailed instructions are given in: Lesson 1-4:
Open and navigate a workbook.



How to use this book

This book utilizes some of the tried and tested techniques developed after teaching vast numbers of people
to learn Excel during many years teaching Smart Method classroom courses.

In order to master Excel as quickly and efficiently as possible you should use the recommended learning
method described below. If you do this there is absolutely no doubt that you will master Excel.

Complete the course from beginning to end

It is always tempting to jump around the course completing lessons in a haphazard way.
We strongly suggest that you start at the beginning and complete the lessons sequentially.

That's because each lesson builds upon skills learned in the previous lessons and one of our goals is not to
waste your time by teaching the same skill twice. If you miss a skill by skipping a lesson you'll find the later
lessons more difficult, or even impossible to follow. This, in turn, may demoralize you and make you
abandon the course.

Because of the unique presentational style, you'll hardly waste any time reading about things that you
already know and even the most advanced Excel user will find some nugget of extremely useful information
in every lesson.

Don’t waste your time reading about techniques you already understand (or have no
interest in)

Here’s a lesson step:

1  save the workbook.

note N

When you are editing a workbook the changes you make are only
You can also use the <Ctrl>+<S> held in the computer’s memory. If there is a power cut or your
keyboard shortcut to save your computer crashes, you will lose any work that has been done since
work. the last save. For this reason, you should get into the habit of

regularly saving your work.

Click the Save button on the Quick Access Toolbar at the top left of
the screen.

If you already know how to save a workbook, read only the line: Save the workbook and just do it. Don’t waste
your time reading anything else. Read the smaller print only when you don’t already know how to do
something.

If you're in a hurry to learn only the essentials, as fast as possible, don’t bother with the sidebars either
unless they are labeled important. Read the sidebars only when you want to know everything and have the
time and interest. You can see an example of this above. Clicking the Save button is the easiest, fastest and
most intuitive method to save a file. You don’t need to know the information in the sidebar (unless you are
interested in it).

If possible, complete a session in one sitting

The Basic Skills course consists of two sessions (each containing a number of lessons).

You'll learn better if you lock yourself away, switch off your telephone, and complete a full session, without
interruption, except for a 15 minute break each hour. The memory process is associative and we've ensured
that the lessons in each session are very closely coupled (contextually) with the others. By learning the whole




session in one sitting, you'll store all of that information in the same part of your memory and will find it
easier to recall later.

The experience of being able to remember all of the words of a song as soon as somebody has got you
"started" with the first line is an example of the memory's associative system of data storage.

Rest at least once every hour

In our classroom courses we have often observed a phenomenon that we call "running into a wall". This
happens when a student becomes overloaded with new information to the point that they can no longer
follow even the simplest instruction. If you find this happening to you, you've studied for too long without a
rest.

You should take a 15 minute break every hour (or more often if you begin to feel overwhelmed) and spend it
relaxing rather than catching up with your e-mails and text messages. Ideally you should relax by lying
down and closing your eyes. This allows your brain to use all of its processing power to efficiently store and
index the skills you've learned. We've found that this hugely improves retention of the skills learned.

At the end of each session, complete the session exercise

Keep attempting the exercise at the end of each session until you can complete it without having to refer
back to lessons in the session. Don't start the next session until you can complete the exercise from memory.

At the end of each session, review the objectives

The session objectives are stated at the beginning of each session.

Read each objective and ask yourself if you have truly mastered each skill. If you are not sure about any of
the skills listed, revise the relevant lesson(s) before moving on to the next session.

You will find it very frustrating if you move to Session 2 before you have truly mastered the skills covered in
Session 1. This may demoralize you and make you abandon the course.

How to best use the incremental sample files

Many lessons in this course use a sample file that is incrementally improved during each lesson. At the end
of each lesson an interim version is always saved. For example, a sample file called Sales-1 may provide the
starting point to a sequence of three lessons. After each lesson, interim versions called Sales-2, Sales-3 and
Sales-4 are saved by the student.

A complete set of sample files (including all incremental versions) are provided in the sample file set. This
provides two important benefits:

e If you have difficulty with a lesson it is useful to be able to study the completed workbook (at the end of
the lesson) by opening the finished version of the lesson’s workbook.

e When you have completed the book, you will want to use it as a reference. The sample files allow you to
work through any single lesson in isolation, as the workbook’s state at the beginning of each lesson is
always available.

Use hyperlinks for easier navigation

Many books consist of disassociated self-contained chapters, often all written by different authors. This
method works well for pure reference books (such as encyclopedias). The problem with this approach is that



there’s no concept of building knowledge upon assumed prior knowledge, so the text is either confusing or
unduly verbose as instructions for the same skill are repeated in many parts of the book.

A goal of this book (and our classroom courses) is not to waste your time by explaining any skill twice. This
enables more material to be taught faster, and in fewer pages.

You may forget something that has already been covered earlier in the course. For this reason, the book
makes extensive use of cross references in the text pointing you back to the lesson in which the relevant skill
was learned. The cross references also help when you use this book as a reference work but have forgotten
the more basic skills needed to complete each step.

Cross references are particularly useful in an e-book as you can click on any of these cross-references to
automatically navigate to the relevant lesson.

2 Create a new worksheet and name it January.

This was covered in: Lesson 1-5: Save a workbook.

~

This is a clickable hyperlink

In the above example, the text: Lesson 1-5: Save a workbook is a hyperlink and will take you to lesson 1-6. You
can try this with the example above.

Note that this will only work if you are viewing the entire e-book (rather than a lesson at a time via the
http://ExcelCentral.com web site.

The free cloud version of this e-book is always available everywhere

As well as reading this e-book from an offline PDF file, you can also read it online from any web browser at:
http://ExcelCentral.com. As well as being convenient, you can always be sure that you are reading the very
latest version of this book.

Home  Sample Files Pricing -~ Forums port ( ct Login

Essential Skills
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Before you start: When you need help:

Read: How to use the course BT Te]l-Xe] =B 1o [ Xo [11Te X m Find a lesson teaching a specific Excel feature
Download the entire e-book eI {ET R CRE (RN &
Download the sample files  BRE\VESSEEEE Y g Rk Ask one of our Excel experts.
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First page of a session

quotation, often from an era
before the age of the computer,
that is particularly pertinent to
the session material. As well as
being fun, this helps us to
remember that all of the real-
world problems we solve with
technology have been around
for a long time.

3/ The session objectives
formally state the precise skills
that you will learn in the
session.

At the end of the session you
should re-visit the objectives
and not progress to the next
session until you can honestly
agree that you have achieved
them.

In a Smart Method course, we
never progress to the next
session until all delegates are
completely confident that they
have achieved the previous
session’s objectives.

1/ The first page begins witha ———

~

\

Sasalont

Database

\Session One: The Sample

Session Objectives

2/ In the next few paragraphs
we informally summarise why
the session is important and the
benefits that you will get from
completing it.

This is important because
without motivation adults do
not learn. For adults, learning is
a means to an end and not an
end in itself.

The aim of the introduction is
to motivate your retention of
the skills that will be taught in
the following session by
allowing you to preview the
relevance of the material that
will be presented. This may
subconsciously put your brain
into “must remember this”
mode —assuming, of course,
that the introduction convinces
you that the skills will be useful
to you!




Every lesson is presented on two facing pages

Pray this day, on one side of one sheet of paper, explain how the Royal Navy is prepared to meet the
coming conflict.
Winston Churchill, Letter to the Admiralty, Sep 1, 1939

Winston Churchill was well aware of the power of brevity. The discipline of condensing information onto
one side of a single sheet of A4 paper resulted in the efficient transfer of information.

A tenet of our teaching method is that every lesson is presented on two facing sheets of A4. We’'ve had to
double Churchill’s rule as they didn’t have to contend with screen grabs in 1939!

If we can’t teach an essential concept in two pages of A4 we know that the subject matter needs to be broken
into two smaller lessons.

Learn Access VBA 2003 with The Smart Method

Lesson 1-1: Understand the
sample database

The sample database will manage a collection of films. The schema

Tips, important information and incorporates some of The Smart Method's preferred naming conventions
. % . and design rules.
notes appear m Sldebars' tlp 1 Create a new folder for your application on the C:\ drive
Some of The Smart called C:\FilmLibrary.
Method’s rules for 2 Download the FilmLibrary-Session1.zip file from
table names and http://www.thesmartmethod.com/Access_VBA_Sample_Files
relationships: save it to this location, unzip it and then re-name it
FilmLibrary.mdb.
[ :{J:E;m”;i‘fi}"‘u‘: 3 Open the FilmLibrary.mdb database.
. . . R 4 Select Tools>Relationships from the main menu to view the
Each step is numbered and begins with 2/The primary bey s always S bom ¥
. s meaningless (ie autonumber
the thing you need to do in bold type. data type) and is named using The schema is displayed.
" P the syntax: <table name> + <ID>
Sometimes this is all you need to read o ks ety bavs
. exactly the same name as
to accomplish the task. lited Prtniry Loy (e
example the primary key
MedialD in the Media table is

also called MedialD in the Film
table.

. . @ 5/ The link table in a many-to-
Step notes sometimes provide precise M
. = . named with them the
instructions on how to progress if the —_| s meitersideaite 5

Understand the table relationships.

many to many relationship (for
One_line descripﬁon iS inadequate. it the F‘I"‘Ad":‘:::les)' Note lhel relatfnnships ?etwgen the tables. It is often useful to read
. . . the relationships to a client from the schema to ensure that they are
Notes often also include interesting Lt tesesies (0 o) correct. For example-
are listed in Appendix A: The

Rules. “One film may have one and only one director but a director may
direct many films.” (A one to many relationship).

information about the current task.

“One film may have many actors and one actor may perform in
many films.” (A many to many relationship).

If you are not Working through the 6  Understand the relationship types.
. . . Right-click on the relationship between the Film and Director
course sequentlall}’/ a ﬁle 1S tables and choose Edit Relationship... from the shortcut menu. The

aVailable on our Web Site that Edit Relationship dialogue is displayed.

contains the starting point for
every lesson. The file name you \

need to download is stated in the

file icon at bottom left of every ™S -
Session1

lesson page. LJ

18 www.thesmartmethod.com




Learning by participation

Tell me, and I will forget. Show me, and I may remember. Involve me, and I will understand.

Confucius (551-479 BC)

Confucius would probably have agreed that the best way to teach IT skills is hands-on (actively) and not
hands-off (passively). This is another of the principal tenets of The Smart Method® teaching system. Research
has backed up the assertion that you will learn more material, learn more quickly, and understand more of
what you learn if you learn using active, rather than passive methods.

For this reason, pure theory pages are kept to an absolute minimum with most theory woven into the hands-
on lessons (either within the text or in sidebars). This echoes the teaching method in Smart Method
classroom courses, where snippets of pertinent theory are woven into the lessons themselves so that interest
and attention is maintained by hands-on involvement, but all necessary theory is still covered.

Session One: The Sample Database

important

Amateur database designers
often leave their databases
open to corruption by not
enforcing referential integrity
between their tables.

The usual excuse for not
enforcing referential integrity is
that it will stop users entering
incomplete records (for
example users may wish to
create a Film record when the
Director name is not known).

The simple solution to this
problem is to make sure that
the default value of the foreign
key within the parent table (the
DirectorID field within the Film
table) is always Null (Null
means the absence of any value
at all). It will then be possible to
create Film records when the
Director is not known.

note

‘You might wonder what
would happen if you checked
the Cascade Update Related Fields
check box.

1f you follow our design rules
all primary keys will be
meaningless (see tip sidebar
and Appendix-A: The Rules).
Amateur database designers
(and even ones that have
simply read the wrong books!)
often create meani

primary keys causing all sorts

Join Type..

Edit Relationships W‘gl
Table/Query: Related Table/Query: -
Director | Fim & _
DirectorID ¥ DirectorID -
-

[JEnforce Referental Intagrity}
[cascade Update Related Fieids
[[]Cascade Delete Related Records

Relatonshp Type: | One-To-Many

Note the Enforce Referential Integrity check box. This means that if a
user attempts to delete a director who is attached to any films the
delete will fail.

It is vitally important to enforce referential integrity for all
relationships within your database. Access does not do this by
default!

Understand when to use Cascade Delete.

Close the Edit Relationships dialogue. Right-click on the
relationship between the Film and FilmActor tables and choose
Edit Relationship... from the shortcut menu. The Edit Relationship
dialogue is displayed.

Edit Relationships E’gl
Table/Query: Related Table/Query: o
Fim W, FimActor
Cancel
FimID N FimID -~

Jon Type..,

Create New..

[V]Cascade Delete Related Records

Relationship Type: = One-To-Many

of problems.
Cascade Update Related Fields Note that the Cascade Delete Related Records check box is
is simply a work around for hackedl.
one of the problems caused by
breaking this design rule - the This is one of the rare examples when Cascade Delete Related
i when a meaningful Records makes sense because we would want to automatically
m ]:93;::‘(’“5’;:: d“’h;\&eg‘e delete the association between a film and it's actors in the event
R dgm%ms& e that the user wanted to delete a film record.
In a properly designed
database you'll never have to
use this option.
www.thesmartmethod.com 19
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Screen grabs are provided in-line with the
text when they can explain what you
need to do more clearly than words
alone.




Learn Excel 2007 Basic Skills with The Smart Method

Using the advanced video player

We have developed our own online video player to make the video lessons excellent for teaching purposes.

While you may find our videos on YouTube, you should always view them at http://ExcelCentral.com, as
our education-focused video player has many unique features.

Quality ¥ | Captions ¥ | Transcript "| Speed v | Buttons v |
B H % > - First Quarter Sales and Profit-T - Eecel 7 H - 8 X
X, - N =
- - =2 #- |E
g o | LR 77 | %7 | = WapTex and. Curopean Sales, IO ce . -

L ¥ B I U-~|[E+ dep-|===|& 5 | Merge & Center ~
Cligboard e i Alignment 4 The challenge for this lesson will be to place a formula in cell "
— -IB & B15 that will compute the sales in January for the New York and o

o 5 n B - - Los Angeles offices. In other words, the addition of the values in =
1 Sales and Profit Report - First Quartar 2008 | L‘.elIS B4 ﬁnd B5
2
: . Feb Mt dversge  Madimul - and we also need to enter a formula into cell B16 that will calculate
4 MNew York 22,000 29,000 19,000 23,333 29,000
3. Los Angeles 200 m00 400 the value of European sales. [OleTWOGS iNe aoaiion oG
& London 18,000 20,000 22,000
7 paris so0  2som 30 numbers in cells B6 to B8]
8 Munich 13,000 15,000 13,000
9 Gales 123,000
10
11 Costs 83,000
12 |Profit 46,000
13 |10% Bonus 4,600
14
15 USA Sales
1$[EurnpeanSales E o
17
18
19
20
21 e H =

sa e I[N other words, the addition of the numbers in

READY

== é@

cells B6 to B8.

Pause Back 10 Seconds Slower | Faster | Full Screen View |

Quality Button Videos are normally shown in FULL HD quality. In some cases your Internet
connection may not be fast enough for FULL HD. This button enables you to change
to a lower quality level that will still work on slow Internet connections.

Captions The Captions button switches the captions at the bottom of the video on and off. All
lessons have captions available.

Transcript This is a feature rarely seen on the Internet. You can resize and move the Transcript
window. When you click on any word in the transcript you will immediately move
to the same place in the video.

Speed This enables you to speed up, or slow down both the video and voice narration.

Buttons This enables you to make the buttons larger when you are using an iPad or similar
touchscreen device.

Back 10 Seconds | This button is very useful when you miss something and want to see it again. You
can also press it more than once to move back 10, 20 or 30 seconds.

Slower/Faster Slows or speeds up the video and voice narration (you can also do this from the
Speed button).

Full Screen View | Blows the video up to full screen. This is also useful when working with a projector.

20 www.ExcelCentral.com
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Session One: Basic Skills

A bad beginning makes a bad ending.
Euripides, Aegeus (484 BC - 406 BC).

Even if you are a seasoned Excel user, I urge you to take Euripides’
advice and complete this session. You'll fly through it if you already
know most of the skills covered.

In my classes I often teach professionals who have used Excel for over ten
years and they always get some nugget of fantastically useful information
from this session.

In this session I teach you the absolute basics you need before you can
start to do useful work with Excel 2007.

I don’t assume that you have any previous exposure to Excel (in any
version) so I have to include some very basic skills.

If you're moving to Excel 2007 from an earlier version, this session will
de-mystify Microsoft’s new fluent user interface (Ribbon).

Session Objectives

By the end of this session you will be able to:

Start Excel and check your program version

Maximize, minimize, re-size, move and close the Excel window
Understand the Application and Workbook windows

Open and navigate a workbook

Save a workbook

Pin a document and understand file organization

View, add, rename, delete and navigate worksheet tabs

Use the Ribbon

Understand Ribbon components

Customize the Quick Access Toolbar and preview the printout
Use the Mini Toolbar, Key Tips and keyboard shortcuts
Understand Views

Use full screen view

Use the help system

© 2017 The Smart Method Ltd
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Lesson 1-1: Start Excel and
check your program version

If you are using Windows XP or Windows 7 the procedure is almost the
same as described here. You should be able to figure out the differences!

1 Click the Windows Start Button e at the bottom left of
your screen.

2 Click the All Programs item at the bottom of the pop-up
menu.

w

Scroll down the list and click on the Microsoft Office item.
4 Pin Microsoft Office Excel 2007 to the start menu.

You'll be using Excel a lot so it makes sense to pin it to the start
menu. This will make it appear at the top of the list in future so
you'll be able to start Excel with just two clicks.

To pin to the start menu, point to Microsoft Office Excel 2007 in the
list, right-click your mouse and then choose Pin to Start Menu from
the shortcut menu.

5 Left-click Microsoft Office Excel 2007 to start the application.

Excel starts and is displayed on the screen:

0n) d =
| Home | Inset  Pagelayot  Formula: Data  Rewie ew @ - = x
7‘ & cawn 1 AdN & o % Genens 9
<
"a_'fv/n[u—_ 2 A EEEEE A - % a3
Diskeeper Corporation Al v fe ™
Extras and Upgrades A 8 C ¢ " M N -
forteManager 1 :l H
Games
LiveUpdate Notice
o 6  Check the program version
Microsoft Developer Network SRR p g :
Microsoft Expression Pickiires —
Microsoft Office i
© Activation Assistant for Microsoft O e . . . |
%2 Microsoft Office Access 2007 Click the Microsoft Office button ' at the top left of the screen and
(%' Microsoft Office Accounting 2008 Games - Ex | O t
= Microsoft Office acalonn__| . . 2] Excel Options .
& o] lopa then click the Excel Options button =_""" "7 =77 | at the bottom right
= s .
& Microsoft Office  pi1, 15 Start Menu of the dialog.
[i7} Microsoft Office Add to Quick L R
(' Microsoft Office S s
s = ) . . . , .
(@ Microsoft Offics  Restore previous versions Click Resources from the left hand sidebar and you'll see the version
(=] Microsoft Office|
@ Micosoft Officd  SendTo ’ number at the bottom of the dialog:
(% Microsoft Office. ¢
M; Microsoft Officel Copy Excel Options [ =
Miciosoft Office Popular [ln Contact Microsoft, find online resources, and maintain health and reliability of your Microsoft Office
Microsoft Office Delete L9 programs.
Reraria Formulas
1 Back o Proofing get updates Check for Updates
roperties
ek Save Get the Iatest updates available for Micrasoft Office.
B ./ |_& ]
Advanced run Microsoft Office Diagnostics Diagnose
Customize Diagnose and repair problems with your Microsoft Office programs.
Add-Ins contact us lﬂj
Trust Center Let us know if you need help, or how we can make Microsoft Office better.
Resources ‘ activate Microsoft Office Adtivate
Activation is required to continue using all the features in this product.
go to Microsoft Office Online Go Online
Get free product updates, help, and online services at Microsoft Office Online.
about Microsoft Office Excel 2007 About
Microsoft® Office Excel® 2007 (12.0,6300.5000) SPL M5O (12.0.6213.1000)

22 This lesson is easier to understand with our FREE video walkthrough at ExcelCentral.com
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Session One: Basic Skills

important

Service Packs

When Excel 2007 was first
released it had many bugs (as
do all computer programs of
any size).

Microsoft is very pro-active at
fixing bugs that are found and
always release these fixes free
of charge as a service pack.

Service packs normally only fix
bugs found in the original
program, but Microsoft
sometimes take things a little
further by including new, or at
least enhanced, features with
their service packs.

I'had many emails from readers
of my book: Learn Access VBA
2003 with the Smart Method
suggesting that some of the
examples didn’t work for them.
In almost every case the
problem was that they were
using an out-of-date version of
the application or the operating
system. After applying the
relevant service packs the
problems vanished.

For this reason it is important
that you make sure your
software is up to date.

note

What if I’'m unable to
upgrade my operating
system or I’'m using a
different operating
system?

Sometimes your corporate
policy will not allow you to
upgrade your operating system
or application service pack.

In this case you can still use this
book but be aware that it is
possible that some of the
features described may not
work as expected (or may not
work at all).

In this example the Excel version is:

about Microsoft Office Excel 2007
Microsoft® Office Excel® 2007 (12.0.6300.5000) SP1 MSO (12.0.6213.1000)

The important part is the SP1 denoting that you have service pack one

installed. If this says SP2, SP3 or an even larger number this is also fine. It

simply means that Microsoft have fixed even more bugs in their product
since this book was published.

If you do not see any reference to SPn, you have an early, un-patched

version of Excel 2007 and you should update it (the update is free) via the

Internet.
7 Check the Operating System version.

Click the About Button next to about Microsoft Excel 2007. A dialog is
displayed with information about your copy of Excel.

This product is licensed to:

Product ID:

View the Microsoft Software License Terms

Warning: This computer program is protected by copyright law and international
treaties. Unauthorized reproduction or distribution of this program, or any portion of &

it, It ivil and criminal ties, and will b ted to th . -]
it, may result in severe dvil and criminal penalties, and will be prosecu e System Info...

maximum extent possible under the law.
Tech Support...

Click the System Info... button. The Operating System (OS) Name and
Version will then be visible at the top right of the dialog:

Vista
Item Value
OS Name Microsoft® Windows Vista™ Ultimate
Version 6.0.6001 Service Pack 1 Build 6001
Windows XP
ftem Value
QS Name Microsoft Windows XP Professiona
Version 5.1.2600 Service Pack 2 Build 2600

Once again, it doesn’t matter if you have Vista running a later service
pack than SP1 (or Windows XP running a later service pack than SP2).

If you're running Vista or Windows XP, any edition will suffice (it
doesn’t have to be the Ultimate or Professional edition).

8 Click the close button on the top right corner of each
dialog to return to the Excel screen.

© 2017 The Smart Method Ltd
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Lesson 1-2: Maximize,
minimize, re-size, move and
close the Excel window

The great successful men of the world have used their imaginations,
they think ahead and create their mental picture, and then go to work
materializing that picture in all its details, filling in here, adding a
little there, altering this a bit and that bit, but steadily building,
steadily building.

Robert Collier, American motivational author, (1885-1950)
Now that Excel is open you are confronted with a dazzling array of
buttons, switches and other artifacts.

For now let’s explore the big picture by looking at how the Excel window
can be sized and moved. The details will come later.

1 Understand the Maximize, Minimize and Restore Down

buttons
At the top right corner of the Excel window you'll see three
buttons.
Maximize, Minimize and Close buttons
C“; R Q) Bookl - Microsoft Excel = = X
- Home Insert Page Layout Formulas Data Review View 9 - 7 X
== % Calibri vi1l = General = A Salnsert ~ - Ap
J 53 |||'Be o U | A AT 7 :‘}' % 9 3% Delete ~ il' Z? }3
" g |[E A WA | Elromat- | 2+ Fer- selear
Clipboard ™= Font ] Alignment (] Number ™= Cells Editing
| AL - £ 5]
Pia s | oc .o J e J e J.6 J . u J . ) =
L | H
2

The buttons that you see will depend upon how the Excel window
was left last time the application closed down. Normally the Excel
screen is Maximized to fill the screeen and you'll see:

Restore Down
M'mimizeI | Cllose

¥

But if you had reduced the size of the Excel window so that it
didn’t fill the screen you'll see this instead:

Maximize
Close

3

Minimize

Try clicking the Maximize, Minimize and Restore Down buttons but
be careful to click the group of three buttons at the very top of the

24
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note

Other ways to close
down Excel

There are three expert ways of
closing Excel that will save a
second or two of your time.

1. Double click the Office
button at the top left of
your screen.

2. Press the <Ctrl>+<W> keys
on your keyboard. We'll be
learning more about
keyboard shortcuts later in
this session.

3. Press the <Alt>+<F4> keys
on your keyboard.

window and not the similar group beneath (we’ll be visiting those
in the next lesson).

B Maximize makes the Excel window completely fill the screen.
B Minimize reduces Excel to a button on the bottom task bar.

L ——

Click this button again to restore the window to its previous size.

B Restore Down makes the Excel window smaller allowing you to
re-size the window.

Re-size the window

After clicking the Restore Down button you are able to re-size the
window. Hover over either the side of the window, or a corner of
the window, with your mouse cursor. The cursor shape will
change to a double-headed arrow.

Ll

When you see either cursor shape, hold down the left mouse
button and move the mouse (this is called click and drag) to re-size
the window.

Clicking and dragging a corner allows you to change both the
height and width of the window.

Clicking an edge allows you to change only one dimension.
Move the window.

Click and drag the Title Bar (the bar at the very top of the window)
to move the Excel Application window around the screen.

Close Excel

There are two common ways to close down Excel and three lesser
used methods (see sidebar). Most people will use one of the
following methods:

Click on the Close button P9 at the top right of the Excel application
window.

OR

(=
Click on the Office button = at the top left of the screen and then
click on the Exit Excel button at the bottom right of the dialog.

© 2017 The Smart Method Ltd
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Lesson 1-3: Understand the
Application and Workbook
windows

Excel can be thought of as a frame (the Application window) containing
one or more Workbook windows. Most of the time you will work with one
Application window containing one Workbook window.

Workbook Close, Minimize
and Restore Down buttons
Workbook window Application Close, Minimize
Application window and Restore Down buttons
| |
= —
q’ RE™ Q) Bookl | Microsoft Excel — = P4
y Home Insert Page Layout Formulas Data Review View © - 7 X
== % calibri -1 - General  ~ | A S=Inset~ | X - f\ ~‘
J;_q (B I U-~||A X B3 o | 3% Delete - || [g]~ 57 ‘}}
2| [E oA E %959 S romat » || 2+ Fiters Sewtts
Clipboard = Font F] lignment {F] Number = Cells Editing
Al vl I
A B C D E F G H 1 J
|
2
3
4
5
6
W4 » M| Sheetl_ Sheetz - Sheet3 . J [ m I
Ready (25 0036 =): U

The screen grab above shows the normal way of working. The Workbook
window is maximized within the Application window.

If the Workbook (that’s the lower group of three buttons) Restore Down
button is clicked the workbook window floats within the frame provided
by the Application window.

Floating (restored) Workbook Close, Minimize
Workbook window and Restore Down buttons
Application Close, Minimize
Application window and Restore Down buttons
I
mn‘ RN™] _l = Microfoft Excel = = X
y Home Insert Page Layout Formulas Data Review View 7]
&  Calibri 11 - | == 5 |Genera ~ A GeInset~ | X - A 5
3 |||[B X U ~|A A Fad ~ :'}‘ % o = 3 Delete ~ gv 7‘7 ﬁ
=t 2 |[EAT] (@ W || Eiromat- || 2~ fners seretts
Clipboard = Font T llignment e} Number = Cells Editing
\ Al - ( fe ¥
@ Bookl = = x
A B C D F G H
0 |
2
3 i
4 <> b Sheet1 Sheet2 ~Sheet3 /¥l 0 | m I s
Ready | (22 O Eja00%); U s

1 Close Excel down and re-start it again.
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note

What'’s the point of
having a floating
workbook window?

At this stage in your journey of
discovery, none at all.

You need to know how to
maximize, minimize and
restore down the workbook
window because you might do
it by accident and need to fix
things up again.

In Lesson 2-2: Create a new
workbook and view two workbooks
at the same time, you'll see how
Excel is able to display more
than one Workbook window
within the Application
window. This allows you to
view two workbooks at the
same time.

Click the Workbook’s Restore Down button (that’s the one in

the lower group of three buttons). mml

The workbook floats within the Application window:

_ ] Microsoft Excel - = X
{ ‘Q' _" H icrosoft Excel
—/ Home Insert Page Layout Formulas Data Review Wiew ‘?_J)
=5 calibri -l -l =| =  General -~ Al =~ 47~
= 53 ||B 7 U -~[|A a7 = ||EE- % oo | @~ #a-
Paste <0 00 Styles | Cells _
- . 7'&'$' ||~ | e - - A
Clipboard Font s Alignment [ Mumber = Editing
| a1 - 5|
F‘i] Bookl = = x
A B c D £ F G H
1 .I =]
2
3
4
4 4 » M| Sheetl ~ Sheet2 - Sheet3 %] J | I 0.
Ready (O [ asesey (=)0 (F))

Notice that the workbook’s Maximize, Minimize and Restore Down
buttons have now moved to the top right corner of the floating

window.
Click the Workbook’s Maximize button.
The workbook completely fills the Application window:

’dm\ ad = Bookl - Microsoft Excel = = x
Y,
- Home Insert Page Layout Formulas Data Review View ® - =7 X
== % || Calibri =l |l General - A L[| E < 4T
= B ||B £ U ~[|A & =g (E- % 0| - #-
Paste = Styles || Cells
- F ||l A 8 % s - 2
Clipboard = Font (F] Alignment (] Number T Editing
| Al \a fe |
A B g D E F G H |
] B
A
3
1
5
6
4 4 » »| Sheetl ~Sheet? - Sheetd %3 0 m ] -0
Ready [EEE TN e =) Cols

Understand the two close buttons.

You've probably noticed that there are two close buttons on screen.

One for the Application window, and one for the Workbook

window. How these buttons work is quite quirky.

Application close button

B Closes both the application and workbook windows when

only one workbook is open, or no workbooks are open.
B Closes only the active workbook (that’s the one that is

currently on display), when more than one workbook is open.

Workbook close button

B Closes the workbook but always leave the application window

open.
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Lesson 1-4: Open and navigate
a workbook

Excel uses the analogy of a book that has many pages. In Excel

important

Organizing your
sample files folder!

When you complete a lesson
that involves a sample file that
is changed, you will be
instructed to save the file with a
suffix.

By the time you’ve completed
the course you'll have sample
files such as:

terminology we use the term: Workbook for the book and Worksheet for
each of the pages. We'll be learning more about worksheets later in this
session in Lesson 1-7: View, add, rename, delete and navigate worksheet tabs.

1 Download the sample files (if you haven’t already done so).

1. Open your web browser and type in the URL:

www.ExcelCentral.com

Sgi; 2. Click the download link on the top left of the home page.
Sales-2 Home Sample Files Register Books Support

Sales-3 ... etc

The first file is a sample file that
you downloaded, and the
others (with the number
postfix) are interim versions as
you complete each lesson.

The sample file set includes the
sample file and all interim
versions.

The interim versions are
provided for three reasons:

1. If your work-in-progress
becomes unusable (for
example after a system
crash) you can continue
without starting at the
beginning again.

2. If alesson doesn’t seem to
give the results described,
you can view the example

Essential Skills

3. Download the sample files for Excel 2007 Basic Skills.

2 Open the sample workbook: The Wealth of Nations.

1. Open Excel and then click on the Office button

left of the screen.

~ at the top

2. Select Open from the drop down menu. Navigate to the folder
containing the sample files and double click The Wealth of
Nations to open the sample workbook.

If you prefer to use the keyboard, another way to open a
workbook is to hold down the <Ctrl> key and then press the

<O> key.

3  Goto Cell ZZ3 using the Name box.

to get some clues about Name BOX ACtiVO CCH Formula Bar
what has gone wrong.
3 When 4 have completed (a a1 i L Wealth Of Nations - Microsoft Excel r i 5
’ the ‘203]1'28 you will uI:;e this - Hdme Insert Page Fyuut Formulas Data Review View 9 - 7 X
book as a reference. The L s catibri 1 1 |=F ==& | Generl Alllgall = -2
interim versions allow you Pa;;] Zal |B £ U -||A 4] = (|5 %l | 8- 4~
to work through any of the - I E S A | 6 3% - v A
IESSOHS in isolation lf you Clipboard ' Font Alignment Number Editing )
need to remind yourself L B3 M C— Y Luxembourg ¥
how to use a specific Excel A B c D E |
feature. 1 button Country GDP - per capita (PPP) Date of Information L
2 1 Qatar $ 80,900 2007 est.
It is a good idea to place the 3 2|Luxembourg I$ 80,500 2007 est.
sample files in a different folder 4 3 Bermuda $69,900 2004 est.

to your saved work. If you
don’t do this you'll be over-
writing the sample interim files
(such as Sales-1, Sales-2 etc)
with your own finished work.

Excel uses the letter of the column and the number of the row to
identify cells. This is called the cell address. In the above example
the cell address of the active cell is B3.

In Excel 2007 there are a little over a million rows and a little over
sixteen thousand columns. You may wonder how it is possible to

name all of these columns with only 26 letters in the alphabet.

’/The Wealth of Nations |
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note
Excel 2007 is big!

"Space is big - really big - you
just won't believe how vastly,
hugely mind-bogglingly big it
is. You may think it's a long
way down the road to the
chemist, but that's just peanuts
to space”.

Douglas Adams, The
Hitchhikers’ Guide to the
Galaxy

A compelling reason to
upgrade from Excel 2003 to the
new 2007 version is the sheer
size of worksheets that can now
be manipulated.

Excel versions 97-2003 were
limited to 65,536 rows and 256
columns.

Many of my clients have
needed to overcome the “65,000
row problem” in earlier Excel
versions. Until now that meant
moving to Access (Microsoft’s
database management
application).

Excel 2007 worksheets can have
up to 1,048,576 rows and 16,585
columns.

Put into more understandable
terms.

¢ You could create a single
worksheet with the name of
every human being on the
planet and you wouldn’t run
out of cells (in fact, you
wouldn’t have even used half
of your worksheet).

o If you filled every cell and
printed out the worksheet it
would be 3.25 miles (5.24
kilometres) long and 320
yards (293 Metres) wide —
that’s a lot of paper.

Believe it or not, some of my
clients aren’t even happy with
this and are now running into
the “million row problem”!

ol

When Excel runs out of letters it starts using two: X,Y,Z and then
AA, AB, AC etc. But even two letters is not enough. When Excel
reaches column ZZ it starts using three letters: ZX, ZY, ZZ and
then AAA, AAB, AAC etc.

The currently selected cell is called the Active Cell and has a black
line around it. The Active Cell’s address is always displayed in the
Name Box and its contents are displayed in the Formula Bar.

We can also use the Name Box to move to a specific cell.

To see this in action, type ZZ3 into the Name Box and then press the
<Enter> key. You are teleported to cell ZZ3:

| zz3 - |
i zs zr 2u zv Zw Zx zv zz

—1

e | W2 |

Return to Cell Al by pressing <Ctrl>+<Home>.

Go to the end of the worksheet by pressing <Ctrl>+<End>.
Use the Scroll Bars.

There are two scroll bars for Excel’s workbook window.

The vertical scroll bar runs from top to bottom of the worksheet
window and allows you to quickly move up and down the
worksheet.

The horizontal scroll bar is at the bottom right hand side of the
workbook window and allows you to move to the left and right in
wide worksheets.

Here’s how the scroll bars work:

- ¥

v wew @ - = x Click here to scroll one
Al @) =-4- | screen up or down
Styl Cell &~ 4
es ells .
— - Click here to scroll
Editing
= one cell up or down.
D E E
2007 est. i
2007 est. Click and drag this
il i : button to quickly move
2o07lest. I q y
—ei—lm‘gg &~ up and down the worksheet.

e If you need more speed hold
2007 est. down the <Shift> key as you
2005 est. | rag.
2007 est. [+] d ag

1L [ ’ﬂ
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note

You can also use the <Ctrl>+<S>
keyboard shortcut to save your
work.

note

You can also use the <F12> key
to instantly display the Save As
dialog.

Lesson 1-5: Save a workbook

1  Save the workbook

When you are editing a workbook, the changes you make are only
held in the computer’s memory. If there is a power cut or your
computer crashes you will lose any work that has been done since
the last save.

For this reason you should get into the habit of regularly saving
your work.

Even though we haven’t changed this worksheet, let’s save it now
by clicking the Save button on the Quick Access Toolbar at the top
left of the screen.

Quick Access Toolbar

(On) 9~

Save Button

2 Save the workbook with a different name.

Click the Office button and then hover the mouse cursor over the
Save As item in the drop-down dialog.

You can see that it is possible to save your file in many different
formats.

E.;g \ d ) - v The Wealth Of Nation
." 4

Save a copy of the document

l';‘ Excel Workbook
11| Save the workbook in the default file i

format.
l': Excel Macro-Enabled Workbook
I Save 51 Save the workbook in the XML-based and
- macro-enabled file format.
H Save As % ooea| Save the workbook in a binary file format q
optimized for fast loading and saving.
» @ j Excel 97-2003 Workbook

1l | Save a copy of the workbook that is fully
compatible with Excel 97-2003.

l': Excel Binary Workbook

e Find add-ins for other file formats
» ,—l Other Formats

i Open the Save As dialog box to select from
all possible file types.

Publish >

3  Understand file formats.

Excel Workbook (the Open XML format)

Until very recently every program stored its information on the
hard disk in a completely different way. These incompatible
formats are called binary formats. This made it very difficult to
write applications that could be used together.

All of this has changed with the new file format: Office Openn XML.
The Wealth of Nations
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How users of earlier
office versions can
read your OpenXML
files

Microsoft has a free download:
The Microsoft Office
Compatibility Pack.

If users of Excel XP (2002) or
2003 install this they will be
able to read and save Word,
Excel and PowerPoint 2007 files
in the new OpenXML format.

If the user has Office 97 or
Office 2000 they are out of luck.
You'll have to save your files in
the old 97-2003 format if you
need to share them.

The Smart Method still runs
many Excel 2000 courses
(especially for clients in the
banking and finance sector).
These users have no solution to
read an Open XML workbook
other than to upgrade.

Of course, as the years pass this
will become less of an issue.

File name: The Wealth of Nations Copy

Save as type: | Excel Workbook

Microsoft have published exactly how this format works and given
it away free to the world’s developer community. This allows
other programs to easily work with Excel workbook files. For
example, Apple’s iPhone already supports Office Open XML Email
attachments.

Unfortunately the future has to co-exist with the past and there are
a lot of people in the world using the older versions of Office (97,
2000, 2002 and 2003). If you save your files in the new Open XML
format only people running Office 2007 will be able to read them
(but see the sidebar for a potential solution to this problem).

Excel Macro Enabled Workbook

The Excel Macro Enabled Workbook is simply a workbook that has
program code (called Macro code) embedded within it. Macros are
beyond the scope of this book but are covered in our Excel Expert
Skills book

Macro programming (also called VBA programming) is a vast
subject of its own and is not useful to the vast majority of Excel
users. The Smart Method run comprehensive Excel VBA courses
but they are usually only taken by scientists and engineers who
need to add very advanced functionality to Excel.

Earlier versions of Excel could potentially allow a workbook to
infect your machine with a macro virus because all Excel files were
capable of carrying macros. By separating the formats it is easier to
avoid opening potentially infected files.

Excel 97-2003 Workbook

This is the old binary format that allows users with earlier versions
of Excel to read your workbooks. Some features won’t work in
earlier versions and if you've used those in your workbook Excel
will display a warning and tell you which features will be lost.

Excel Binary Workbook

An oddity in Excel 2007 is a new binary format: Excel Binary
Workbook. This is a binary alternative to Open XML but it can’t be
read by earlier versions of Excel. The advantage of this format is
that it loads and saves more quickly than Open XML.

Save the workbook with a different name.

1. Click on the Excel Workbook icon.

2. Type: The Wealth of Nations Copy into the File name text box.
3. Click the Save button.

Notice that the name of the workbook in the title bar (at the
top of the window) has now changed indicating that you are
now viewing the new workbook that you have just saved.

© 2017 The Smart Method Ltd
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tip
Increasing the
number of items in

the recent documents
list.

Excel remembers the seventeen
most recently opened
documents.

As you open more documents
the seventeenth oldest is
removed from the Recent
Documents list unless you pin
it.

If you’d like to increase Excel’s
memory up to a maximum of
fifty items here’s how it’s done:

1. Click the Office button at
the top left of the screen.

2. Click the Excel Options
button at the bottom right
of the dialog.

3. Choose Advanced from the
left hand pane.

4. Scroll down the right-hand
list until you find the
Display category. You'll see
Show this number of Recent
Documents: 17.

5. Change the number to the
number of recent
documents you’d prefer
Excel to remember (up to a
maximum of fifty).

Lesson 1-6: Pin a document
and understand file
organization

1 Close down and restart Excel.
2 Pin a workbook to the Recent Documents list.
1. Click the Office Button at the top left of the screen.

On the right hand side of the dialog is a list of all recently
opened documents beginning with the most recent (probably
the Wealth of Nations worksheet opened during the last lesson).

Note that there is a pin icon .ﬁ next to each workbook name.

When you hover the mouse cursor over the pin a tooltip is
displayed saying: Pin this document to the Recent Documents list.

ld:‘;& ad QA= Bookl - Micr
rJ.-‘

Recent Documents
) e
The Wealth Of Mations =

N
Open

Il =
[

This can be a great time saver as it enables any workbook that
you use a lot to always be in the Recent Documents list. You
won’t have to waste time looking for it on the hard drive.

1

2 BN |
J Pin this document to the Recent Documents list.

3 200oorees

4 Menu Week Commencing 25th June 2008 =

2. Click the pin icon. The icon changes from unpinned _-W to

pinned.

Recent Documents

1 The Wealth Of Mations L
2 BMI20O07 [=1
3 2008 Bikes 1=

3. Click on The Wealth of Nations to open the workbook.
3 Understand file organization.

By default Excel saves all workbooks into your documents folder
along with other Office documents (such as Word and PowerPoint
files). This clearly is going to cause problems when you have a few
hundred files.

Better to organize yourself from the start by setting up an orderly
filing system.
I create a folder called Excel beneath the Documents folder

(Windows Vista) or the MyDocuments folder (Windows XP). In this
folder I create subfolders to store my work. You can see a screen
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Folders

4§ Excel
. Accommodation
. Accounts
. Bank Reconciliations
. Bank Statements
. Book Publishing
. Budgets
. Business and employment
. Cars and motorcycles
. Credit Cards
. Currency
. Diet
. Inflation Figures RPI RPIX
. Insurance
. Miscellaneous
. Perscnal
. Recipes
. Stationery Orders
. Taxes
. Training
J Travel
. Tutorials
. VBA Examples
| Web Sites

tip
Learning more about
file organization.

Microsoft have some good
ideas about good file
organization. You can read
their recommendations at:

www.microsoft.com/atwork/
manageinfo/files.mspx

grab of my Excel folder in the sidebar (of course, your needs will
be different to mine).

Set the default file location.

If you take my advice and create an Excel folder you will waste a
mouse click every time you open a file because Excel will take you
to the documents folder by default.

Here’s how to reset the default file location to your new Excel
folder:

Ca
1. Click the Office button -~ at the top left of the screen.

2. Click the Excel Options button at the bottom right of the
dialog.

3. Choose the Save category from the left hand side of the dialog.
4. Change the default file location.

You have to actually type in the default file location. Microsoft
seems to have forgotten to add a browse button!

Excel Options
Popular :
Customize how workbooks are saved.
Farmulas
Proofing Save workbooks
Save ] Save files in this format: Excel Workbook
Advanced Save AutoRecover information every |10 -
Customize AutoRecaver file location: | CUsers\MSmart\AppData
Default file location: ChlUsers\MSmart\Excel
Add-Ins
Trust Center AutoRecover exceptions for: [-:| Eookl
Resources [] Disable AutoRecover for this workbook only

When you click Office>Open in future you'll automatically be
taken to your Excel folder ready to choose a category.

During the remainder of the book I'll explain the above sequence
of choices like this:

Click: Office>Excel Option->Save, and then change the default file
location.

This will save a lot of time and forests!

© 2017 The Smart Method Ltd
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Lesson 1-7: View, add, rename,
delete and navigate worksheet
tabs

When you save an Excel file onto your hard disk, you are saving a single
workbook containing one or more worksheets.

You can add as many Worksheets as you like to a Workbook.

There are two types of worksheet. Regular worksheets contain cells.
Chart sheets, as you would expect, each contain a single chart. Charts are
not covered in this Basic Skills course but have an entire session devoted
to them in the Essential Skills book in this series (Session Five: Charts and
Graphics).

1 Open The Wealth of Nations from your sample files folder (if
it isn’t already open).

2  Move between worksheets.

Look at the tabs on the bottom left corner of your screen. Notice
that this sample workbook contains three worksheets: GDP, Life
Expectancy and Mobile Phones. Click on each tab in turn to view
the different worksheets.

GDP - Life Expectancy | Mobile Phones %

3  Add a new worksheet.

1. Click the Insert Worksheet tab (the tiny tab next to Mobile
Phones). A new tab appears named Sheet1.

2. Double-click the Sheet1 tab.
3. Type the word Population followed by the <Enter> key.

GDP - Life Expectancy Mobile Phones | Population  #3
4 Move a worksheet's tab.
1. Click on the Population tab (you may have to do this twice).

2. Drag to the left. As you drag you'll notice an icon of a page
and a black arrow telling you where the tab will be placed.

3. Release the mouse button to move the tab to the location of
your choice.

27 J B
4 4 » M| GDP - Life Expectancy Mobile Phones | Population %1

5 Understand the tab scroll buttons

Because this workbook only has four tabs, there’s no need to use
the tab scroll buttons (in fact, they won’t work at all when all tabs
are visible).

’/The Wealth of Nations |
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First
Previous
Next
Irast

4 4> M

When there are more tabs than will fit on the screen the tab scroll
buttons are used to move between tabs.

Move between worksheets using the keyboard.

You can move between worksheets using only the keyboard by
pressing the <Ctrl>+<PgUp> and <Ctrl>+<PgDn> keyboard
shortcuts to cycle through all of the tabs in your workbook.

Change tab colors.

The colored tab feature was only added in Excel 2003 and most
users have yet to discover that they can color code their tabs.
Others will be very impressed if you color code yours!

1. Right-click on any of the tabs and choose Tab Color from the
shortcut menu.

2. Choose any color.
3. Repeat for the other tabs on the worksheet.
Delete a worksheet.

Right click on the Population tab and select Delete from the
shortcut menu.

Delete several worksheets at the same time.
1. Hold down the <Ctrl> key.

2. Click each tab you want to delete in turn. Don’t select them all
as it isn’t possible to delete every worksheet in a workbook.

3. Right click any of the selected tabs and select Delete from the
shortcut menu.

Don’t worry about the missing tabs. We’'re going to close the
workbook without saving it so you won’t overwrite the original
workbook.

Close the workbook without saving it.
1. Click Office>Close.
A dialog is displayed:

Microsoft Office Excel (3]

! . Do youwant to save the changes you made to The Wealth Of Nations.dsx'?

[ Yes ] | Mo | | Cancel |

2. Click No so that you don’t over-write the workbook.

Because you haven’t saved the workbook it will remain in its
original state when you next open it.

© 2017 The Smart Method Ltd
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note Lesson 1-8: Use the Ribbon

Older versions of Excel hid all Look what they've done to my song, Ma

of their best features Look what they've done to my song

saaleesiih el aincaine Speitan of Well it's the only thing I could do half right

menu navigation. Many users i .

didr’'t know that half of the And it's turning out all wrong, Ma

features were there at all. Look what they've done to my song

Because Only the standard and Song lyric by Melanie (M. Safka)

formatting toolbars were

visible on screen, users didn’t The Ribbon causes huge frustration for seasoned Excel 97 to 2003 users as
explore the menu options and, everything seems to be in the “wrong place”. “Look what they’ve done to

instead, used only a tiny subset

Excel” they cry. But it’s a better, and an entirely new, way of working.
of Excel’s features. ycry y y g

The Ribbon makes Excel seem The sheer breadth of Excel features can seem overwhelming. This book

overwhelming because all of will gently introduce all of the most important features, one at a time. By
those features are right in your the end of the book you’ll be really comfortable and productive with the
face. Ribbon.

Hardly anybody in the 1  Start Excel and open a new workbook.

workplace today understands

every one of Excel’s features. 1. Click Office>New.

You'll be doing productive

work with Excel by session two The New Workbook dialog appears.

of this book while using a tiny

subset of the full feature set. By New Workbook (7 =S
the end of the book you’ll be Templates e s¢(>| || Blank Workbook =
thoroughly competent working Blank and recent

Wlth Excel. Installed Templates Blank and rec...

m

m

My templates...
Mew from existing...
Microsoft Office Online

Featured Elank Workbook

n Ote Agendas

Budgets
The Ribbon shows Calendars
more if you have a Expense reports A |
wide screen [ cancer |
When I'work with Excel I use a 2. Double-click the Blank Workbook icon to create a new blank

22 inch widescreen monitor
running at 1,680%1,050 pixels.

workbook.

2  Use Ribbon tabs.

Excel uses the extra screen
space to display extended
descriptions of each feature on
the Ribbon.

Each Ribbon tab has its own toolkit available to you. By far the
most important tab is the Home tab which has buttons for all of the

most common and useful features.
For example, the Styles pane on

the Home Ribbon expands to Click each tab in turn and view the buttons. The screen grab below
show buttons for nine common has the Insert Tab selected. Don’t worry if the buttons seem cryptic
cell styles allowing them to be at the moment. Most of them will make complete sense by the end
applied with a smgle click of this book.

rather than two clicks.

If you later go on to complete the Expert course too, Excel will
have no mysteries left at all!

Home Insert Page Layout Formulas Data Review View @ - @ X

] - Rl ) N AA =] b o Q A =] :] 5
B R =l B e b o = 4 4 &
PivotTable Table Picture Clip Shapes SmartArt | Column Line Pie Bar Area Scatter Other Hyperlink Text Header WordArt Signature Object Symbol
R Art 2 . 7 v v v Charts~ Box & Footer Y Line v

Tables Illustrations Charts I3 Links Text
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contextual tabs

If you are doing something
special, such as previewing a
worksheet, Excel doesn’t want
to bother you with a lot of
commands that are irrelevant.

For this reason you'll often see
a cut-down version of the
Ribbon, listing only the
commands that are available at
that time. For example, when
you change to print preview
view (we cover that later in
Lesson 1-10: Customize the Quick
Access Toolbar and preview the
printout), you'll see a cut-down
Ribbon with only one tab
containing all of the things you
are able to do when previewing
a printout.

Sometimes Excel will show you
even more tabs. For example,
when you select a picture, a
Picture Tools tab group will
magically appear containing a
Format tab. This enables you to
enhance the picture.

note

Other ways to show
and hide the Ribbon

1. Press <Ctrl>+<F1>.

2. Right-click anywhere on
the Ribbon and choose
minimize the Ribbon from
the shortcut menu.

You can do any of the above a
second time to bring the Ribbon
back.

If you close Excel with the
Ribbon hidden it will still be
hidden when you re-open it.

Customize Quick
Access Toolbar
Button l

Ca) d 9" B
o/
-’ Home Insert

Type the word Test into any blank cell and then press the
<Enter> key on the keyboard once.

Notice how the Active Cell moves to the cell beneath.

A B

Test

-

Make the cell with the word Test into the active cell.

Click once on the word Test or use the arrow keys on the keyboard
to navigate back to the cell. Be very careful not to double-click
otherwise Excel will think that you want to edit the cell.

A B
1

2 Test I

Click the Home tab on the Ribbon and focus upon the Font
panel (it's the second panel from the left). Try clicking each
of the buttons and you will see the word Test change to
reflect your choices.

This drop-down allows you to
change the font to something
different to the default Calibri.

Click here once to make the:|
text Bold, Italic or Underlined
(or all three). Click again to
restore it to Normal.

This drop-down arrow allows — length of the bottom of the
you to add a double underline.

This drop-down allows you to
change the size of the font
(measured in points).

Calibri

These buttons allow you to
change the cell’s background
and text colour.

Bl il

Clicking here puts a single
underline along the entire

cell. Try the drop-down arrow
too for more border options.

6

Minimize the Ribbon.

To minimize the Ribbon in order to save screen space, click the
Customize the Quick Access Toolbar button (see sidebar) and choose
Minimize the Ribbon from the drop-down menu. Notice how the
Ribbon now takes up far less screen space.

An even quicker way of doing the same thing is to double-click
any of the tabs.

Double-click once more to bring the Ribbon back to full size.
Save your work with the name Ribbon Test and close Excel.

Click Office->Save As>Excel Workbook, type in the file name
(Ribbon) and then click the Save button.

© 2017 The Smart Method Ltd
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Lesson 1-9: Understand
Ribbon components

The whole is more than the sum of its parts.
Aristotle, Greek critic, philosopher, physicist & zoologist
(384 BC - 322 BC)

The Ribbon is made up of several different artifacts.

g Normal button

Simply executes a command when clicked. The Bold button on the Home
tab is a good example.

= Menu button
+Hm
H This type of button has a little down-arrow on it. It will display a Menu

Insert  ©or Gallery when clicked.

Split button

This is the hardest button to understand because these buttons look
almost the same as the menu or gallery button. When you hover the mouse
cursor over a split button, the icon and drop-down arrow highlight
seperately as different “buttons within a button”.

(==
F

Il- A good example is the underline button on the Home toolbar.

U | Underli Clicking the icon part of a split button (the U) will perform the default
= =nhoerine action of the button (in this case a single underline). Clicking the arrow
D Double Underline part of the button will display a menu of further choices (in this case the

choice between a single and double underline).

Check box
Gridlines
A little square box that you can click to switch an option on or off.

v View
In this example (from the Page Layout Ribbon) you are able to switch the

Print gridlines on and off for the screen display and/or the printout.

Command group

General N Similar actions are grouped into a cluster. For example, every component

relating to numbers is clustered into the Number group.
21 - I::I'Il ¥ «.0 .00
= a 00 .0

Mumber U
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LL1
fm |
==
[Insert |

-

g

Insert Cells...

Insert Sheet Rows

C LU MO

C

Insert Sheet Columns

Insert Sheet

E_E.H-

Dialog launcher

Dialog launchers appear on the bottom right-hand corner of some
command groups. Dialogs offer more choice than it is possible for the
Ribbon to express graphically. Many of the dialog launchers will present
a dialog that is identical to the old dialogs from Excel 2003.

General -
[ .0 .00
-“'_25' % *|[TEn &0

Mumber I

Dialog launcher

Drop down list

I often shorten this to simply “Drop Down” in this book. A drop down is
a simple menu listing several choices.

If you see an ellipsis (...) after a drop down list item this means that a
dialog will be displayed after you click, offering further choices.

Drop down gallery

This is a little like a drop down list but has graphics to visually
demonstrate the effect of each choice.

Styles ~
Good, Bad and Neutral

Normal Bad Good Neutral

Data and Model
| I | Explanatory ... Note
Output Warning Text

Rich menu

The rich menu is Microsoft’s way of trying to coerce you into being brave
enough to use a feature that you might not have understood in previous
Excel versions. A sort of an “in your face” help system.

;EI This rich menu can be found at:
View>Window—>Freeze Panes
Freeze
RN The Freeze Panes feature is not
[FLEmRlET N _ covered in this Basic Skills book
Keep rows and columns visible while the rest of but i <l fin-clesiin im i
the worksheet scrolls (based on current selection). ut 1s ?Over'e n- e}_) lr.l e.
Freeze Top Row Essentml Skills book in this series
:I Keep the top row visible while scrolling through (in Lesson 3-16: Freeze Columns
the rest of the worksheet, and Rows).
Freeze First Column
Keep the first column visible while scrolling
through the rest of the worksheet.
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note

If you are used to an
earlier version of
Excel you might
wonder where all of
the toolbars have
gone?

In earlier versions of Excel it
was possible to create as many
of your own custom toolbars as
you wanted.

The new Ribbon based user
interface (Microsoft calls this
the Fluent Interface) means that
you don’t need to create
toolbars to the same extent in
Excel 2007, because every panel
on the Ribbon is, essentially, a
toolbar.

Lesson 1-10: Customize the
Quick Access Toolbar and
preview the printout

In Excel 2007 you may have just one custom toolbar: the Quick Access
Toolbar. In this lesson we’ll add some useful buttons to the Quick Access
Toolbar to save a few clicks.

The Quick Access Toolbar is one of the keys to being really productive
with Excel 2007. This lesson will introduce you to the main features.

1 Open The Wealth of Nations from your sample folder, (if it
isn’t already open).

2 Preview how the Life Expectancy worksheet will look when
printed.

1. Click the Life Expectancy tab at the bottom of the worksheet.
2. Click Office>Print->Print Preview:

€ = - = The Wealth OF Nation
Y
j Preview and print the document
HNew
i JI Print
~u [ Select a printer, number of copies, and
7 QOpen other printing options befare printing,
{ qi' Quick Print

Customize Quick
Access Toolbar
Button |

(O d 9~ g
o/
el Home Insert

Customize Quick Access Toolbar
New
Open
vV | Save
E-mail
Quick Print

Print Preview

Spelling
v | Undo
v | Redo

Sort Ascending

Sort Descending

More Commands...
Show Below the Ribbon

Minimize the Ribbon

H Save ‘:‘QH Send the workbook directly to the default
- 3

printer without making changes.

rl s Print Preview
Save As » ", Preview and make changes to pages before
printing.

| Print Preview (Cirl+F2)

:il,_i] Print L
A preview of how the page will print is displayed.

Notice that the Ribbon now displays a contextual menu
because there are only a few options open to you when
previewing.

3. Click the Next Page and Previous Page buttons to move through
the print preview.

4. Use the Zoom button to magnify the page for a clearer view.
5. Click the Close Print Preview button to return to the workbook.
3 Add a Print Preview button to the Quick Access Toolbar.

Print Preview is a very useful feature and you’ll probably use it a
lot. Every time you use it, however, it is going to take three clicks
of the mouse. Wouldn't it be better if you could show a print
preview with just one click?

1. Click the Customize Quick Access Toolbar button (see sidebar).

2. Click the Print Preview item in the drop-down list.

—

’/The Wealth of Nations
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note

Some amazing Excel
features cannot be
used at all without
customizing the
Quick Access
Toolbar!

One of my favourite features in
Excel 2007 is its ability to read
the workbook to me via its Text
to Voice facility.

When I need to input lots of
numbers from a sheet of paper
and want to check them I get
Excel to read them to me as I
tick each off my list. This is
much faster and nicer than
continuously looking first at the
screen, then at the paper, for
each entry.

This feature is covered in depth
in the Expert Skills book in this
series.

You can’t use this feature at all
unless you add some custom
buttons to the Quick Access
Toolbar!

tip
The Quick Access Toolbar is

one of the keys to being really
productive with Excel 2007.

Always try to minimize the
number of mouse clicks needed
to do common tasks.

If you find yourself forever
changing tabs to use a button,
change two clicks into one by
adding the button to the Quick
Access Toolbar.

All of those extra clicks add up
to a lot of time over the weeks
and years.

A new button now appears on the Quick Access Toolbar. You
are now able to Print Preview your work with a single click of
the mouse.

o)\ H9- )

- Home Insert P

4 Add a Font Color button to the Quick Access Toolbar.

The More Commands... option is available when you click the
Customize Quick Access Toolbar button. This enables you to add any
command in Excel to the toolbar. But there’s an easier way!

1. Click the Home tab on the Ribbon (if it isn't already selected)

A
2. Right-click on the Font Color button in the Font Group.

TS

A i= =] M| .0 .00

I>s Add to Quick Access Toolbar

LCustomize Quick Access Toolbar..,

Show Quick Access Toolbar Below the Ribbon

Minimize the Ribbon

3. Click Add to Quick Access Toolbar.
A Font Color button is added to the Quick Access Toolbar.

Do) O EH9- SA)F
3) -

5 Remove a button from the Quick Access Toolbar.

1. Right-click on the Font Color button you've just added to the
Quick Access Toolbar.

2. Click Remove from Quick Access Toolbar on the shortcut menu.

6 Add separators to make heavily customized Quick Access

toolbars more readable.

1. When you add many items to the Quick Access toolbar it is a
good idea to use separators to split icons into logical groups.

2. Click the Customize Quick Access Toolbar button. |E|

3. Click More Commands... on the shortcut menu.

< Separator>

4. Click the item at the top of the Commands list.

Add ==

5. Click the Add>> button.

6. Usetheup El and down IZI buttons to move the

separator to the required location.

Here’s a screen grab of my own Quick Access Toolbar:

Ca 0-DN &P =il | O-A % BB H) T
&
4 Home Insert Separators 7 Formulas Data Review View Developer
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important

Keyboard shortcuts
don’t work with the
numeric keypad

It's a strange quirk of Excel that
you must use the number keys

along the top of your keyboard
when using keyboard shortcuts
that involve a number.

If you use the numeric keypad
on the right of your keyboard
they won’t work.

note

Keyboard shortcuts
are one of the secrets
of maximizing
productivity with
Excel

Many years ago I took my
mouse and stuck it to the back
of my monitor with sticky tape.

For a whole day I struggled to
work without it.

The first few hours weren’t
much fun but after that my
work became faster and faster.
It became a challenge to figure
out how to do things without
the mouse.

You will be far more
productive if you can get into
the same habit.

These days, there are some
things that you simply need the
mouse for, and some things
that are genuinely faster (or
easier) with the mouse. For
most common tasks, however,
there are keyboard shortcuts
and Excel 2007 has just made
things a lot easier with the new
Key Tips feature.

Lesson 1-11: Use the Mini
Toolbar, Key Tips and
keyboard shortcuts

1 Open the Wealth of Nations sample worksheet (if it isn’t
already open).

2 Select cell B2 (Qatar) on the GDP worksheet.
1. Click on the GDP tab.
2. Click on cell B2 (Qatar).

Make sure that you only click once otherwise Excel will think
that you are trying to edit the cell.

A B C
1 |button Country GDP - per capita (PPP)
2 1|aatar 15 80,900

3 Make cell B2 (Qatar) bold, italicized and underlined.
1. Click Home->Font->Bold
2. Click Home—>Font->Italic
3. Click Home—>Font->Underline

A B C
1 button Country GDP - per capita (PPP)
2 1|Qatar 15 80,900

4  Display Key Tips.
Hold down the <Alt> key on the keyboard.

Notice how Key Tips are now displayed on the Ribbon and the
Quick Access Toolbar:

/ -. ” L A -
- Wil Inse Pag out Formulas
Tef
j L) Page Break Preview H

IjJCustcum‘u‘iews Y| Gridlines
Mormal| Page
Layout = Full Screen

Workbook Views Show

5 Use the Key Tips to show a print preview using only the
keyboard.

The key tips reveal the key you need to press to simulate clicking
any of the Ribbon and Quick Access Toolbar icons.

Hold down the <Alt> key and press the relevant number to show a
print preview.

’/The Wealth of Nations NB: Your toolbar, and the number you need to press, may Iook.
different to the screen grab above. For example, the print preview
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note

If you don’t like the
Mini Toolbar you can
switch it off

Personally I really like the mini
toolbar and wouldn’t dream of
switching it off but if you are
used to an early version of
Excel and find that it annoys
you, here is how it’s done:

1. Click the Office button.

2. Click the Excel Options
button at the bottom right
of the dialog.

3. Click the Popular item in
the left-hand list.

4. Uncheck the Show Mini
Toolbar item.

5. Click the OK button.

note

The shortcut menu

If you right-click on a cell, a
shortcut menu is displayed.

The shortcut menu doesn’t
display everything that you can
do to a cell but Excel’s best
guesses at the most likely things
you might want to do.

Because Excel is guessing at the
actions you might want to take
in the context of what you are
doing, the shortcut menu is also
sometimes referred to as the
contextual menu.

button will not be on the Quick Access Toolbar unless you added it
during: Lesson 1-10: Customize the Quick Access Toolbar and preview
the printout.
Click the Close Print Preview button == to return to normal
Use the mouse to select the text Qatar in cell B2.
1. Double-click the cell containing the text.

You'll see the cursor flashing in the cell.

2. Position the cursor just after the word Qatar and hold down
the left mouse button.

3. Drag the mouse across the complete word until it is
highlighted like this:

oot

Observe the Mini Toolbar.

Hover the mouse cursor over the selected text and you should see
a “ghost” image of the Mini Toolbar just above the cell:

- i _.Fxl Ilatar
1 Calibri 11 -

Bl A-A A

el |

octar .

When you move the mouse cursor up and over the Mini Toolbar it
will light up.

Use the Mini Toolbar to restore the text to non-bold and non-
italic.

Click on the Bold and Italic buttons to remove the bold
and italic attributes from the text.

Qatar

Show a bigger Mini Toolbar with a right-click.

Right-click on Bermuda (Cell B4). Notice that, as well as the
shortcut menu (see sidebar) you now get an even better Mini
Toolbar with a few extra buttons.

Remove the underline from Qatar.
1. Click on Qatar again (cell B2).

2. Press the <Ctrl>+<U> keys on the keyboard to remove the
underline.

But how can you remember cryptic keyboard shortcuts like
<Ctrl>+<U>? Fortunatelﬁ you don’t have to. Hover the mouse over

the underline button and you'll see the keyboard shortcut

listed in the tooltip.

© 2017 The Smart Method Ltd
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The Wealth of Nations I

Lesson 1-12: Understand
views

Views are different ways to look at your worksheet.

Excel 2007 has three views. They are:-

View Icon ‘ What it is used for

Normal This is the view you’ve been using until now.
% It’s the view most users use all of the time
when they are working with Excel.

Page layout This is a fantastic new view for Excel 2007. It
allows you to see (almost) exactly what the
[i printout will look like.

Unlike running a Print Preview you are able
to edit cells just as you can in Normal view.

Page break m A page break is when the printer advances
preview onto a new sheet of paper.

1 Open the Wealth of Nations sample worksheet (if it isn’t
already open).

{,’@ B H R A‘é 3 The Wealth Of Nations - Microsoft Excel - =
Home Insert Page Layout Formulas Data Review View
| j 0 5 ';{ | ‘ E_\] cENewWindow = |13 |
p 1 i b = Arrange Al T |l | H ~
Normal| Page Show/Hide, Zoom 100% Zoomto = e Save Switch Macros
Layout 5 v Selection || Ol Freeze Panes ~ ] | 414 | workspace Windows ~ -
Workbook Views Zoom Window Macros
| D23 - @ fe | 2007 est. v
A B c ) E F | cm
1 button Country GDP - per capita (PPP) Date of Information :
2 1 Qatar $80,900 2007 est.
3 2 Luxembourg $ 80,500 2007 est.
4 3 Bermuda $ 69,900 2004 est.
5 4 Jersey $57,000 2005 est.
6 5 Malta $53,400 2007 est.
7,  6Norway  $53000 2007 est.
4 4 » ¥ | GDP - Life Expectancy .~ Population - Mobile Phones I |
Ready | E:E] ED] 6__;U| G’).ui?h
View buttons

2 Click on the GDP tab and then click on the page layout view
button at the bottom of the screen.

The worksheet is displayed in page layout view. It is a little like Print
Preview view as you are able to see (almost) exactly what will be
printed. Headers, footers and margins are all shown.

Unlike Print Preview view you are able to edit the worksheet.

You may wonder why we don’t use page layout view as the
default when editing worksheets. While some users may prefer to
do this, most will want to see the maximum amount of data
possible on screen and so will prefer the Normal view.
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@0 H9-c-RA]-
ciad

Home Insert Page Layout Formulas

E m | Page Ereak Preview i C%

I:‘]J Custom Views

Mormal | Page

Show/Hide| Zoom 100% Zoomto

The Wealth Of

Data Revigl

19 Metherlands

20 British Virgin Islands
21 Austria

22 Canada

23 Gibraltar

24 Denmark

25 United Arab Emirates

Layout | (= Full Sereen - selectior|
Workbook Views Zoom
| D23 - fx | 2007 est.
\ ] .].l = = .ll = .2| 1 .El 1 -ll 1 .El - 5| = .]'l |
A B
|18 17 Andorra
i 18 Iceland

H 4k M

GDP - Life Expectancy .~ Population .~ Mobile Phones %]

Ready | Page:1 of10 |

3 Click the page break preview button.

The worksheet is displayed in page break preview view (you may

also see a help dialog first).

This view shows each page with a watermark to indicate which

sheet of paper it will be printed on:

A E C
2z 21 Austria $ 32,400
23 22 Canada $32.400
24 23 Gibraltar $38,200
26 24 Denmark, ™ . $374004
26 25 United Arab Emirates” =4 [ | #5800 |
27 2E Sweden = B 111
22 27 Australia $ 36,300

Eelgium #36,300

felam d

u] E
2007 est.
2007 est.
2005 est,
2007 est.
2007 est,
2007 est.
2007 est.
2007 est.

AT - o

A, E c

47 46 Mew Zealand 4 26,400
45 47 lsrael 4 26,800
43 4% Bahamas, The % 26,000
A0 44 Falkland Islands= [Islas Malvinas 26,000
51 _A0 Liechtenstein _ __ __ _ _ __ & 25,000
52 81 Karea, South 424,800
A3 52 Czech Republic 424,200

F 24,000

b4 52 Oman

2007 est,
2007 est,
2007 est.
2002 est,
1999 &=t
2007 est.
2007 est.
2007 est.

fatat et Y

It is possible to click and drag the dotted line to change the place

where the page breaks.

This view is not covered in this Basic Skills book but is covered in
depth in the Essential Skills book in this series (in Session Seven:

Printing Your Work).
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Lesson 1-13: Use full screen
view

1 Open the Wealth of Nations from your sample files folder (if it
isn’t already open) and click the Life Expectancy tab.

!./ﬁg H9- s The Wealth Of Nations - Microsoft Excel - =
- Home  Insert Page Layout Formulas Data Review | View Developer '@J - 7 X
ﬁi Research \j agid QA‘ Protect Sheet @ Protect and Share Workbook
@Thesaurus a1} 3:2}Protecl:‘.v\forlt:bool(v @Allow Users to Edit Ranges
Spelling ., Mew
a3 Translate || Comment ~a o || ko Share Workbook |3 Track Changes ~
Proofing Comments Changes
I F14 - k| ¥
A B & D
1 |Rank Country Life expectancy at birth Date of Information
2 1 Andorra 83.53 2008 est.
3 2 Macau 82.35 2008 est.
4 3 Japan 82.07 2008 est.
5 4 Singapore 81.89 2008 est.
6 5 5an Marino 81.88 2008 est.
7 6 Hong Kong 81.77 2008 est.
8 7 Canada 81.16 2008 est.
9 8 France 80.87 2008 est.
10 9 Sweden 80.74 2008 est.
11 10 Switzerland 80.74 2008 est.
4 4 » M| GDP | Life Expectancy .~ Population Mobile .
Ready | 5] |JW p dj L

Notice that the Ribbon, formula bar and status bar are all taking up
space that could be used to display information. In the example
above only the first eleven rows are visible.

1 Double-click on any of the Ribbon tabs to hide the Ribbon.

.'/E- H9- s The Wealth Of Nations - Microsoft Excel - = X
Home Insert Pagelayout Formulas Data Review View Developer @ — @ X
I F14 - e |
A B C D
1 |Rank Country Life expectancy at birth Date of Information
2 1 Andorra 83.53 2008 est.
3 2 Macau 82.35 2008 est.
4 3 Japan 82.07 2008 est.
5 4 Singapore 81.89 2008 est.
6 5 San Marino 81.88 2008 est.
7 6 Hong Kong 81.77 2008 est.
8 7 Canada 81.16 2008 est.
9 & France 80.87 2008 est.
10 9 Sweden 80.74 2008 est.
11 10 Switzerland 80.74 2008 est.
12 11 Australia 80.73 2008 est.
13 12 Guernsey 80.65 2008 est.
14 13 Israel 80.61 2008 est.
15 14 Iceland 80.55 2008 est.
16 15 Anguilla 80.53 2008 est.
4 4 » M| GDP | Life Expectancy .~ Population Mobile [| N[
Ready | 3 |—@ ol

With the Ribbon hidden things are a little better. Sixteen rows are
now visible. Perhaps you may need to view even more. This is
what Full Screen View is for.

2 Click View>Workbook Views—>Full Screen.

The Wealth of Nations
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A
1 |Rank Country
2 1 Andorra
3 2 Macau
4 3 Japan
5 4 Singapore
6 5 San Marino
7 6 Hong Kong
8 7 Canada
9 8 France
10 9 Sweden
11 10 Switzerland
12 11 Australia
13 12 Guernsey
14 13 Israel
15 14 Iceland
16 15 Anguilla
17 16 Cayman Islands
18 17 New Zealand
19 18 Italy
20 19 Gibraltar
21 20 Monaco
22 21 Liechtenstein
23 22 Spain
24 23 Norway
25 24 Jersey
26 25 Greece
27 26 Austria
28 27 Virgin Islands
29 28 Malta
30 29 Faroe Islands
31 30 Netherlands
32 31 Luxembourg
33 32 Montserrat
34 33 Germany
4 4 » M GDP _ Life

§x| The Wealth Of Nationsxlsx - Microsoft Excel

tan

Population

C D E F G H |
Life expectancy at birth Date of Information

83.53 2008 est.
82.35 2008 est.
82.07 2008 est.
81.89 2008 est.
81,88 2008 est.
81.77 2008 est.
81.16 2008 est.
80.87 2008 est.
80.74 2008 est.
80.74 2008 est.
80.73 2008 est.
80.65 2008 est.
80.61 2008 est.
80.55 2008 est.
80.53 2008 est.
80.32 2008 est.
80.24 2008 est.
80.07 2008 est.
80.06 2008 est.
79.96 2008 est.
79.95 2008 est.
79.92 2008 est.
79.81 2008 est.
79.65 2008 est.
79.52 2008 est.
79.36 2008 est.
79.34 2008 est.

79.3 2008 est.
79.29 2008 est.
79.25 2008 est.
79.18 2008 est.
79.15 2008 est.

79.1 2008 est.
Nwg ¢34

Mobile Phone-s l -

Note that the Quick Access Toolbar, the Ribbon, the formula bar
and the status bar have all vanished. On the above example shown
at 1,024*768 screen resolution 34 rows are visible.

On my own 22 inch monitor running at 1,680%1,050 pixels in
portrait mode I can view 81 rows of information on one screen.

Switch back to normal view.

To return to normal view either:

Press the <Esc> key on the keyboard.

OR

Right click in any cell and then click Close Full Screen.

© 2017 The Smart Method Ltd
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Lesson 1-14: Use the help
system

1 Click the Help button L7 at the top right of your screen.

The help dialog is displayed:

If your screen doesn’t look like this, click the show/hide table of
contents button.

Type a question here to search the help
system for answers.

Keep on top
. button
Tip .
Show/hide Choose which content
The Keep On Top table of to view and search
button contents
Find help by catego

When this button is pinned in 4 S
like this: |~ | the help window @ Bxcd Help | - s =
will stay on top of all open GRS ISRORA AN . s
Office windows. ribbon - P Search ~

Table of Contents X A
When the button is unpinned & What's new - i

@ Getting help
like this the window will @1nstaling

|
be hidden if you move other W Acivaiing el ‘ ‘

. . & Customizing £ What's new Getting help
Office windows on top of the : ; A o T
help window. .g/rFile conversion and compatibility ==
Note that this is only the case 2  Type how do | save a file into the search box followed by

with Microsoft Office windows
and not with windows from

the <Enter> key.

other applications. The help system provides many potential answers to the question:
€ Excel Help - o x
B x5 6 asMl e =
How do I zave a file + /2 Search -
Table of Contents 3¢ | Excel Home -
.\V/\“a’hat’s new = o ‘: ‘
@ Gettnghelp H Se_artihed for: "How do I save |7
& Instaling i a file
.\.//Acﬁvaﬁng Excel
& Customiang Results 1-25 of top 100  Page: [1] 2 3 4
Accessibili '@ Save a file
54 ; ty_ - Help = Workbook management > File
.\\\(/FHE conversion and compatibility management
.\V/Saving and printing . )
M\Mnrkhnnk management @ :ﬂtﬁ?:;;‘calw save a backup copy ofa
.\.//File recovery Help = Workbook management > File
= management
MFHE management
@) How daylight saving time (DST) chany @ Demo: Set a password to open or modify
i Enable suoport for other file formats, ™ Ial_\:\_ro‘rll(_l.r.?gﬁ_dﬂc_ument, or presentation 5
< L1} | + 1 T ] 3
AlE |18, Sonnestesie Offics Online 3

3 Click on the most likely answer to read the help topic.

Step by step instructions are displayed showing how to save a file.
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4 Find help by category.

_ Let’s do the same thing now using the category pane. The

category pane is a little like a web page. You find the answer to
Getting help your question by navigating a series of hyperlinks.

Activating Excel Close down the help system and re-start it. Look at all of the
categories and decide which is most relevant. See if you can find a
help topic for saving a file by navigating the hyperlinks. On my
Saving and printing system I got there by clicking Workbook Management->Saving
and Printing->Save a File but your links may differ.

Accessibility

The same help topic found earlier is displayed.
5  Choosing which content to search.

Excel is a huge application and just one help reference wouldn’t be
enough. As well as the help files stored on your hard disk you can
also search a perpetually updating help resource on-line at
Microsoft via the Internet.

Click the drop-down arrow next to the Search button at the top of

& Search .
the Help dialog.

The Search drop-down menu appears:

73 Search =

@ Content from Office Online
" All Excel
Excei Hilp These resources

Excel Templates — are accessed over
Excel Training the Internet

Developer Reference

& Content from this computer
Excel Help ___These resources are

Developer Reference ‘ on your hard disk

The Developer Reference contains topics only of interest to
programmers who understand VBA macro code. This is a very
advanced subject and is covered in the Excel Expert Skills book in
this series.

6 Get help directly from the Ribbon.

G I 5 Insert ~ . .
;nerao t} A f’ b 1. Click the Home tab on the Ribbon and hover the mouse cursor
- % i over the drop down arrow to the right of the word General in

«.0 .00 Styles || .. F tv
| T6o 50 > || B Forma the Number group.

Number T Cells

If you keep the mouse still, after a short delay a screen tip
pops up providing a short description of what the drop-down
Choose how the values in a cell are list is for and also advising that you can obtain more help by

displayed: as a percentage, as .
currency, as a date or time, etc. pressing the <F1> key on your keyboard‘

Number Format

@ Press F1 for more help. 2. Press the <F1> button (at the top left of your keyboard) to
obtain help about topics relevant to this control.

- 7 Obtain help directly from a dialog.
C: \1 -
:"'/ Office Button Click Office>Save As.

— At the top right corner of the Save As dialog there is a help button
H Save As @)

(if you are using Windows Vista).

Click it for detailed help about the Save As dialog.
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In this exercise you'll try to remember the name of each of the Excel screen elements. The answers are on the
next page so you might want to recap by turning the page for a little revision before you start.

Keep trying until you are able to name each of the screen elements from memory. We’ll be using this
terminology during the remainder of the book so it's important that you can correctly identify each element.

A
B/

C) @

ten e
LR i

- ¥

Bookl - Microsoft Excel =

o
/ Home Insert Page Layout Form@las D§a Review View g X

= ScalllE H) =) || Sensetr || X v -
] & Calibri u -[A a3 =i General - EL_J‘ 7’4 L 3 é?‘ 3’}
£ £ = 56 I Delete ~ j T
iEiE| - 51} v % 9 |/%8 5%/ Conditional Format Cell Lot . Sort& Find &
= = > || Formatting ~ as Table ~ Styles~ || {2 Format ¥ || (2~ Filter~ Select~
Clipbogd ™= Faht iF] Aligrgnent i Number ] Styles Cells Editing

=3 -
Paftej ngv;.‘\)._A-~

W N LS W N

=
(=NE=

NN R e e e e
&rw»—!omoo\noxmhwm
i

[SRES]
a0
1

~N
~

4

i
v (),

-

14 »

Sheetl - Sheet2 ~Sheet3 i m
7 |50 Hjia00%u(>)

0 -0 © ©
o 9
o

ady)

If you need help
slide the page to
the left
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Ribbon
Office button

Name Box

Quick Access
Toolbar

Active Cell

Formula Bar

Title bar

Minimize, Maximize
and Close buttons:

Column Header

For Excel application ——
For this worksheet

) ELECDL
g
w Home Insert Page Layout

=] &

Paste

Clipbogd Fant

5| catieri 11 - |[ASASE
(B I U~ i~ Al

Formglas Dga Review

1 Aligrgnent

Bookl - Microsoft Excel

Number &l

%

Fad~ |@3 v oy 9 |58 5%| Conditional Format  Cell
E @ . i Formatting ~ as Table - Styles ~

Styles

Sansetr | X v %? L?a

™ Delete - | (g~

o __ Sort& Find &

) Format = || 2~ Fiter~ Select~
Cells Editing

Q n‘«ﬂL

v ( pj

Wil N O VS W N

~N NN NN R e e e e
\me:hrmv-iowm\;mmbwm)-tc

4

-

4

Sheet1 - Sheet2 - Sheet3 %

Heady

Sheet Tabs
Row Header

Tab Scroll Buttons

— New Sheet
tab

|
Status Bar

View buttons

Scroll Bars

i1}
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Session Two: Doing Useful
Work with Excel

Only those who have the patience to do simple things perfectly ever
acquire the skill to do difficult things easily.

Unknown author

Now that you’ve mastered the basics you are ready to do really useful
work with this amazing tool. In this session you will learn to use all of
Excel’s basic features properly. This will put you way ahead of anybody
that hasn’t been formally trained in Excel best practice. You'll be doing
simple things, but you'll be doing them perfectly!

Even after years of daily use many users are unable to properly use
Excel’s fundamental features. They often reach their goal, but get there in
a very inefficient way simply because they were never taught how to do
things correctly. By the end of this session you'll be astonished with how
well you are working with Excel. What originally seemed like a baffling
array of little colored buttons will suddenly all begin to make sense.

Session Objectives

By the end of this session you will be able to:
Enter text and numbers into a worksheet
Create a new workbook and view two workbooks at the same time
Use AutoSum to quickly calculate totals
Select a range of cells and understand Smart Tags
Enter data into a range and copy data across a range
Select adjacent and non-adjacent rows and columns
Select non-contiguous cell ranges and view summary information

Re-size rows and columns

|

|

|

|

|

|

|

|

B Use AutoSum to sum a non-contiguous range

B Use AutoSum to quickly calculate averages

B Create your own formulas

B Resize a column and create functions using Formula AutoComplete
B Use AutoFill for text and numeric series

B Use AutoFill to adjust formulas

B Use AutoFill Options

B Speed up your AutoFills and create a custom fill series
B Use the zoom control

|

Print out a worksheet
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Lesson 2-1: Enter text and
numbers into a worksheet

Excel beginners tend to reach for the mouse far too often. One of the keys
to productivity with Excel is to avoid using the mouse when entering
data. In this lesson we’ll quickly populate a worksheet without using the
mouse at all.

1

tip
Entering numbers as
text

Sometimes you need Excel to
recognize a number as text.

If you type an apostrophe (‘)
first, Excel won’t display the
apostrophe but will format the
cell as text. You'll notice that
the number is then left justified
to reflect this.

When a number is formatted as
text you cannot perform any
mathematical calculation with it.

First Quarter Sales and
Profit

Open the Sample file: First Quarter Sales and Profit.

A B C D
1 |Sales and Profit Report - First Quarter 2008
2
3 Jan Feb Mar
4 |New York 22,000 29,000 19,000
5 Los Angeles
6 |London
7 | Paris
8 Munich

Notice the difference between values and text.

Cells can contain values or text. Values can be numbers, dates or
formulas (more on formulas later).

Excel usually does a great job of recognizing when there are values
in a cell and when there is text. The giveaway is that text is always
(by default) left aligned in the cell and values are right aligned.

Look at the numbers on this worksheet. Notice how they are all
right aligned. This lets you know that Excel has correctly
recognized them as values and will happily perform mathematical
operations using them.

Save a value into a cell.

1. Type the value 42000 into cell B5. Notice that the mouse cursor
is still flashing in the cell.

420004

At this stage the value has not been saved into the cell.
If you change your mind, you can still undo the value by

pressing the <ESC> key at the top left of your keyboard or by

clicking the Cancel button on the left hand side of the
Formula Bar.

2. Decide that you want to keep this value in the cell by either
pressing the <Enter>, <Tab> or an <Arrow> key on the

"

keyboard, or by clicking the Confirm button on the

Formula Bar.

Enter a column of data without using the mouse.

When you enter data into a column there’s no need to use the
mouse. Press the <Enter> key after each entry and the active cell
moves to the cell beneath. Try this now with the following January
sales data:
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important

The many ways of
entering numbers

Negative numbers

-123.56
(123.56)

Currency prefixes

Excel is quite happy for you to

prefix a number with a currency

symbol. The currency symbol it
will accept depends upon how

you defined the regional options

in your operating system.

$123.56 (works in USA)
£123.56 (works in UK)

Formatting currency values in
any way required (whatever
your locale) is covered in depth

in the Essential Skills book in this

series (in Session 4: Making Your
Worksheets Look Professional).

Commas
12,234,567.78

Fractions

You must leave a space between

a number and a fraction for this
to work.

61/4
(six, space, one, /, four)

The above will appear on the
worksheet as 6.25 after you
enter it in this way.

01/4
(zero, space, one,/,four)

The above will appear on the
worksheet as 0.25. The leading
zero is needed to prevent Excel
from thinking that you are
entering a date.

Formula Blar

- I | January

B & D
t Report - First Quarter 2008

IJanuaE !Feb Mar

22,000 29,000 13,000
42,000 39,000 43,000 s
Sheet2 - Sh[/JH m B

m e

15[ 0| 20036 (=) 1 (El

1. Type 18,000 into cell B6.
2. Press the <Enter> key to move to cell B7.

3. Do the same to enter the relevant values into the next two cells.

3 Jan Feh Mar

4 Mew York 22,000 29,000 19,000
5 |Los Angeles 42,000

6 London 18,000

7 |Paris 33,000

8 |Munich 12,000

Enter a row of data without using the mouse.

When you enter a row of data you also don’t have to use the
mouse.

1. Clickin Cell C5.
2. Type 39,000 and then press the <Tab> key on your keyboard.

The <Tab> key is on the left hand side of the keyboard above
the <Caps Lock> key. Notice how pressing the <T'ab> key saves
the value into the cell and then moves one cell to the right.

3. Type 43,000 in cell D5 and press the <Enter> key.

4. You magically move to cell C6 as Excel assumes you want to
begin entering the next row.

Complete the table without using the mouse.

By using the <Tab> or <Enter> key in the right place you should be
able to complete the table now without using the mouse:

A B C D
3 Jan Feb Mar
4 |New York 22,000 29,000 19,000
5 |Los Angeles 42,000 39,000 43,000
6 London 18,000 20,000 22,000
7 |Paris 35,000 26,000 31,000
8 Munich 12,000 15,000 13,000

Change the text in cell B3 to January.

1. Double-click cell B3. Notice that there is now a flashing cursor
in the cell.

Jlan |

2. Type uary on the keyboard to change Jan to January.
3. DPress the <Enter> key.
Change the text in cell B3 back to Jan using the formula bar.

Click once in cell B3 and then change the text in the formula bar
(see sidebar).

Save your work as First Quarter Sales and Profit-2.
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tip Lesson 2-2: Create a new
Other ways of workbook and view two
creating a new workbooks at the same time

workbook

e Use the keyboard shortcut 1 Create a new workbook by opening Excel

<Clrl+<N>. The easiest way to create a new workbook is to simply open Excel.
¢ Add abutton to the Quick Excel helpfully creates a workbook, unimaginatively named

Az Lo Bookl. If you already have a workbook open called Book1, the new
See more details of how this is workbook will be called Book2... and so on.
done in: Lesson 1-10: Customize
the Quick Access Toolbar and Open Excel now and see this in action. Notice that Book1 — Microsoft
preview the printout. Excel is displayed on the Title Bar.

Oa = R Bookl - Microsoft Excel - = X
nOte -;-"/; Home | Insert  Page layout Formulas Data  Revie Addlins @ - T X
== % |calibri MR == — F=r o, = - A7
What are templates? Jo lmroaxl= - 3~ 8-
Pavste 7 || Ty - ﬁ - [~ NuTber Sty;les Cevlls 7

The vast majority of users Clipboard 1 Font F} gnment 1 Editing
know. nothing about templates | AL - £
and simply base every A . c 5 c - S ; =
workbook upon the Blank 1 =]
Workbook default template 5 "
supplied by Microsoft.
The Blank Workbook template 2  Create another new workbook.

has no information in the

T e o You wouldn’t want to have to open and close Excel every time you

all of the Excel Option settings needed a new workbook.

such as the default font size a

2Rl 1. Click the Office button —~ at the top left of the screen and
Templates can also contain click the New button on the dialog:

anything that a workbook can

contain and are used to store — xTALl'=
workbook frameworks to give &3 | ) | e
you a flying start when you ' '_“/
find that you often create very »
similar workbook layouts. New
If you explore the New
Workbook dialog a little more, . .
you'll see that there are 2. The New Workbook dialog is displayed:
hundreds of pr'e—bullt templates New Workbook BRI
provided by Microsoft.
. Templates i Sei|= | || Blank Workbook =
Many of Microsoft’s templates Blank and recent
have been created using some Installed Templates Blank and rec...
very advanced Excel skills and My templates.. i
techniques. If you make use of New from existing... j e
them there’s a danger that you Microsoft Office Online
may depend upon a workbook Featured e ooy
you don’t understand and are Agendas
unable to maintain. Budgets
Templates you create yourself Catendars
are far more useful. Creating Eipense reports - -
your own custom templates is Cancel
beyond the scope of this Basic
kil ti d i .
Skills course but is covered in 3. Double-Click the Blank Workbook template. A new blank

depth in the Essential Skills
book in this series (in Lesson 3-
14: Create a Template).

workbook called Book2 is displayed in the workbook window.
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note

Finding a workbook
when many are open

An alternative way to quickly
find a workbook when many
are open is to click
View—>Window->Switch
Windows.

This presents you with a list of
all open workbooks.

Save Switch Macrd

Workspace Windows = w
[ v || 1 Book?
2 Bookl

You can also use the
<Ctrl>+<Tab> keyboard
shortcut to cycle through all
open workbooks.

Ci5 Mew Window [ Split
= Arrange All ! Hide

.ﬂ Freeze Panes = || Unhide

Windo

Arrange All

Tile all open program windows
side-by-side on the screen.

Arrange Windows @

Arrange

(7 Tiled

(71 Cascade

[ windows of active workbook

o ) [ |

You could be forgiven for thinking that nothing has happened but
you can see that the Title Bar now says: Book2 — Microsoft Excel,
showing that you are now looking at a different workbook.

See the What are templates sidebar for more information about
templates.

Use the buttons on the taskbar to move between workbooks.

You’ll see two buttons on the taskbar at the bottom of the screen:

W

Click on the buttons to show each workbook in the worksheet
window. The only difference you will see is the Title Bar changing
from Book1 to Book2 because both workbooks are empty.

See the sidebar for other methods of switching windows.

Show both Book1 and Book2 in the worksheet window at the
same time.

This skill often draws a gasp of amazement from my students.
Believe it or not, most Excel users don’t know how to do this.

1. Click View>Window->Arrange All. The Arrange Windows
dialog is displayed.

2. Choose the Horizontal arrangement and click the OK button.

Both workbooks are now shown within the workbook window:

6’3\ = _lé ¥ Microsoft Excel - B X
]
—/ Home Insert Page Layout Formulas Data Review View @
== # | calibri -l -|{= v bl Al l| = -

Past: = ) Mumb Styl Cell E' .‘3’3'
aste umber es ells
- 7 Shal| A - - - | <2
Clipboard ™ Alignment (P Editing
| Al - L |
II\?‘i]Bc:czld - o x
A B G D E F G H

o I

2

4 4 » »| Sheetl ~Sheet2 - Sheet3 ~¥J [ | [—TTE— 0.
A B C D E F G H

1

2

M 4 » M| Sheetl  Sheet2 ~Sheet3 . %1

Ready |(EO ooty GV @

Notice that as you click each workbook window the title bar lights
up and the Close/Minimize/Restore Down buttons appear, to show
that this is the active workbook.

Close Book2 and Maximize Book1 to restore the display to a
single workbook.

If you’ve forgotten how to do this, refer back to: Lesson 1-3:
Understand the Application and Workbook windows.
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Lesson 2-3: Use AutoSum to
quickly calculate totals

Excel’s AutoSum feature is a really useful and fast way to add the values

anGCd Ote in a range of cells together.
I ran an Excel course for a small 1 Open F.ir.st.QL’Jarter Sales and Profit-2 from your sample files
company in London a couple of folder (if it isn’t already open).

ears ago.
Y & 2 In cell A9 Type the word Total followed by the <Tab> key.
The boss had sent his two office
staff to learn a little more about The cursor moves to the right and is now in cell B9:
Excel.

A B C D

Before the course began I asked 7 Paris 35,000 26,000 31,000
the delegates how long they had 8 Munich 12,000 15,000 13,000
been using Excel. They told me 9 |Total

that they’d been using it for two
years to do all of their office
reports.

3 Click Home—>Editing—> (this is the Autosum button).

When I showed them AutoSum A .
they gasped in delight. “This utosum

will save us hours” they told

. Button

I'was curious how they had I
been doing their reports before.

Believe it or not, they had been / ? ﬁ
adding up all of the figures in j

each column with a calculator = Sort & Find &
and then manually typing the L7 Filter v Select~
totals at the bottom of each Editing

column.

Ty o s i s bl v Something interesting has happened to the worksheet:

them Excel as he had heard it a B c D
was very good. Unfortunately
he had not initially seen the 3 Jan Feb Mar
need to train the staff in its use. 4 |Mew York :: 22,00[;? 29,000 19,000
With no training it seemed quite 5 |Los Angeles ! 42,000 j 39,000 43,000
. I !

loglcal to them to use it like a A LCIr'IdCIn ! IE,DDD 5 ED,DDD EE,DDD
word processor and the boss i :: :j
had still been delighted that his 7 |Paris ! 32,000 | 26,000 31,000
staff were using such impressive 8 Munich fo_ 12,000, 15,000 13,000
technology. _

8y 9 Total |=sumZEE) |

10 | SUM{numberl, [number?], ...] |

Excel has placed a marquee around the number range that
AutoSum has guessed we want to work with. The pattern of dots
that marks the boundary of the marquee is called the marching ants
(that really is the technical term for them)!

The marching ants surround all of the numbers in the column
above, up to the first blank cell or text cell (in this case, up to the
word Jan).

=Sum(B4:B8) is your first glimpse of an Excel Formula. Formulas
always begin with an equals sign. This formula is using the SUM

function to compute the Sum (or total) of the values in cells B4 to

BS.

First Quarter Sales and
Profit-2

60 This lesson is easier to understand with our FREE video walkthrough at ExcelCentral.com



http://excelcentral.com/excel2016/basic/tutorials/default.html?adw=1
http://excelcentral.com/excel2016/basic/tutorials/default.html?adw=1

Session Two: Doing Useful Work with Excel

tip
Entering an AutoSum

using only the
keyboard
You can also execute an

AutoSum using the keyboard
shortcut:

<Alt>+<=>

7

Press the <Enter> key or click the AutoSum button @ once
more to display the total January sales:

A B C D

3 lan Feb Mar

4 MNew York 22,000 29,000 159,000
5 |Los Angeles 42,000 39,000 43,000
& |London 18,000 20,000 22,000
7 |Paris 35,000 26,000 31,000
g |Munich 12,000 15,000 13,000
9 Total 129,000

Type the word Total in cell E3 and press the <Enter> key
once.

The cursor moves down one row and is now in cell E4.

B C D E
3 |lan Feb Mar Total
a 22,000 29,000 19,000 |
5 42,000 39,000 43,000

Use AutoSum to calculate sales for New York.

1. Click Home->Editing=> AutoSum. EI

This time AutoSum correctly guesses that you want to sum the
values to the left of cell E4:

B C D E

3 |Jan Feb Mar Tcntal

4l 22000 "29000 15,000 {=sum(He) |
5 42,000 39,000 [ SUM(numberl, [numberZ], ..
6 18,000 20,000 22,000

2. Press the <Enter> key, or click the AutoSum button once more.

n [ 5 First Quarter 5ales and Profit-2.xlsx - M - = x
—//I Home Insert Page I ForrnL Data Reviey V|ew Develu Add-Ii '@) - =7 X
| 17 - f | ¥
A B C D E K
1 |Sales and Profit Report - First Quarter 2008
2 E
3 Jan Feb Mar Total 3
4 MNew York 22,000 29,000 19,000 70,000
5 LosAngeles 42,000 39,000 43,000
6 London 18,000 20,000 22,000
7 Paris 35,000 26,000 31,000
8 Munich 12,000 15,000 13,000
9 Total 129,000
4 4 » »| Sheetl ~Sheet2 . Sheet3 -~ ¥J m
Ready | [

Save your work as First Quarter Sales and Profit-3.
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Lesson 2-4: Select a range of
cells and understand Smart
Tags

Sometimes you don’t want to add all of the values in a column. You only

want to add a selection of cells that you define yourself.

This lesson shows you how to do this with a different AutoSum
technique.

1 Open First Quarter Sales and Profit-3 from your sample files
folder (if it isn’t already open).

2  Observe the formula behind the value in cell B9.

Click on cell B9 or move to it with the arrow keys on your
keyboard.

Look at the formula bar at the top of the screen. Notice that the cell
displays the value of a calculation and the formula bar shows the
formula used to calculate the value:

B9 - f | =sum(B4:Bs)
A B c D
8 Munich 12,000 15,000 13,000
9 Total 129,000
| |
10
" Value Formula

3 Delete the contents of cell B9.

The easiest way to delete the contents of a cell is to press the
<Delete> key on your keyboard but you can also right-click the cell
and then click Clear Contents from the shortcut menu.

4 Change the word Total in cell A9 to USA Sales and press the

8 Munich 12,000
9 |USA Sales

A0

<Tab> key once.

1 You don’t have to delete the word Total before typing USA Sales.

When you click in a cell and immediately begin to type, the
existing cell contents are replaced.

The cursor moves to cell B9.
5  Select cells B4:B5 with your mouse.

When the mouse cursor hovers over a cell there are three possible
cursor shapes:

First Quarter Sales and
Profit-3
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note

Selecting cells with
the keyboard

To select cells with the keyboard
hold down the <Shift> key and
then use the <Arrow> keys to
select the range needed.

note

Selecting a large
range of cells with the
<Shift>-click
technique

If you need to select a very large
range of cells it is sometimes
useful to use this technique:

1. Click the cell in the top left
corner of the required
range.

2. If necessary, use the scroll
bars to make the bottom
right corner of the required
range visible.

3. Hold down the <Shift> key.

4. Click in the bottom right
corner of the required
range.

@ | 64,000 |

Formula Omits Adjacent Cells
Update Formula to Include Cells
Help on this error

Ignore Error

Edit in Formula Bar

Error Checking Options...

Cursor What it does

CN1.6 The white cross (Select) cursor appears when
" you hover over the centre of the cell. You can
then click and drag to select a range of cells.

1.6 The black cross (AutoFill) cursor appears

' when you hover over the bottom right-hand
corner of a cell. We'll be covering AutoFill
later in this session.

1.5 | The four headed arrow (Move) cursor appears
=8 when you hover over one of the black edges of
the cell (but not the bottom right corner).

Beginners often have difficulty selecting cells and end up moving
them or AutoFilling them by mistake.

Position the mouse at the centre of cell B4 so that you see the White
Cross (select) cursor. When you see the white cross, hold down the
left mouse button and drag down to cell B5.

You have now selected cells B4 and B5 (in Excel speak we say that
you have selected the range B4:B5).

A B
3 Jan
4 |New York 22,000
5 |Los Angeles ‘:312,000

Click the Autosum button. z

USA sales are shown in cell B9. Notice the small green triangle at
the top left of B9. This is Excel’s way of saying: “I think you may
have made a mistake”.

9 USAsales 64,000

Select cell B9 and you will see an Exclamation Mark icon. This is
called a Smart Tag.

Hover the mouse cursor over the Smart Tag.

A tip box pops up telling you what Excel thinks you may have
done wrong (see below). Of course, in this case, everything is fine.
The Smart Tag thinks that perhaps we didn’t want just the USA
sales — but the Smart Tag is mistaken!

USA Sale <> ~| 64,000 |

[The formula in this cell refers to a range that has additional numbers adjacent to it.]

Examine the remedial actions suggested by the Smart Tag.

Click the drop-down arrow next to the exclamation mark icon. A
list of possible remedial actions is displayed. In this case you can
choose Ignore Error to remove the green triangle from the corner of
the cell.

Save your work as First Quarter Sales and Profit-4.
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Lesson 2-5: Enter data into a
range and copy data across a
range

Now that you have mastered the technique of selecting cells, you can use
it to speed up data entry.

When you select a range of cells prior to entering data, Excel knows that
all data entered belongs in that range. Several key combinations are then
available to greatly speed up data entry.

1 Open a new workbook and save it as Data Range Test.
2  Select cells B2:D4.

A B £ D E

| | | b

3  Type London.
The text appears in Cell B2, the top left cell in the range selected.
4 Press the <Enter> Key.
The cursor moves to cell B3 as it normally would.
5 Type Paris followed by the <Enter> key.
The cursor moves to cell B4 as it normally would.
6 Type New York followed by the <Enter> key.

This time something new happens. The cursor doesn’t move to cell
B5 as you might expect but jumps to cell C2.

A B c D E m
: B
L London
3 Paris
4 New York
5 =

7  Type 150,000 followed by the <Enter> key.

The value appears in C2 and Excel moves down the column again

to cell C3.
A B C D E m
! E
2 London 150,000
3 Paris
4 MNew York 1
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10

11

12
13

14

Press the <Enter> key without entering a value to leave C3
blank.

Excel moves down the column to cell C4.
Type 225,000 followed by the <Enter> key.
The cursor jumps to cell D2.

Press <Shift>+<Enter> twice to change your mind about
leaving Paris blank.

1. Press <Shift>+<Enter> to move backwards to New York sales.

2. Press <Shift>+<Enter> a second time and you are back to the

Paris cell.

A B c D E m
! E
2 London 150,000
3 Paris
4 New York 225,000 1
3 -

Type 180,000 followed by the <Tab> key.

<Tab> moves you across the range, to cell D3.

A B = D E

L J

London 150,000
Paris 180,000
New York 225,000

ok | R

-

You can now appreciate how to use this technique of <Enter>,
<Tab>, <Shift>+<Tab> and <Shift>+<Enter> to save a lot of time
when entering a whole table of data.

Select cells D2:D4.
Type 50% but don’t press the <Enter> or <Tab> keys.

The challenge this time is to place the same value into cells D3 and
D4 without having to type the value two more times.

Press <CtrI>+<Enter>.

The value is replicated into all of the other cells in the range.

A B C D E ‘5
- E
2 London 150,000 50%
3 Paris 180,000 50%
4 Mew York 225,000 SD%_
5 -

© 2017 The Smart Method Ltd



Learn Excel 2007 Basic Skills with The Smart Method

Lesson 2-6: Select adjacent
and non-adjacent rows and
columns

1 Open First Quarter Sales and Profit-4 from your sample files
folder (if it isn’t already open).

2  Select all of column A.

Hover the mouse cursor over the letter A at the top of the column.
The button lights up and the mouse cursor changes to a black

down arrow:
a* B C
1 Sales and Profit Report - First Quarter 2008

Click to select the entire column. The column becomes slightly
shaded and a black line surrounds all of the cells.

L2 |

New York 22,000

3 Click Home—>Font->Bold to bold face the column.

Because the whole column was selected, all of the values become
bold faced.

4 Click Home—>Font->Bold once more to change the type back
to normal.

5  Select all of row 4.

To select a row, hover the mouse cursor over the number on the
left hand side of the row. The button lights up and the mouse
cursor changes to a black arrow pointing across the row:

3 Jan
= |MNew York 22,000
5 Los Angeles 42,000

Click to select the row.
6  Select columns B and C.

Hover over the letter at the top of column B until you see the black
down arrow. When you see the arrow, click and drag to the right
to select both columns.

First Quarter Sales and
Profit-4
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A B C D
1 Sales and Proyjit Report - First Quarter 2
2
3 Jan Feb Mar
4 |New York 22,000 29,000 19,000

7  Select rows 6 and 7.

Hover over the number at the left of row 6 until you see the black
arrow pointing across the row. When you see the arrow, click and
drag down to row 7 to select both rows.

5 LosAngeles 42,000 39,000
6 [London 18,000 20,000
= [Paris 35,000 26,000
[2R || Munich 12,000 15,000

8  Select columns A, B, C, D and E.

Sometimes you will need to select a large number of adjacent
columns or rows. You could drag across them but it is often easier
to use the following technique:

1. Select Column A.
2. Hold down the <Shift> key.
3. Select Column E.

Columns A to E are selected.

1 |Sales and Profit Report - First Quarter 2008

9  Select rows 4 and 6.

Perhaps you need to perform an operation on two non-adjacent
rows. To select rows 4 and 6 you need to:

1. Select row 4.
2. Hold down the <Ctrl> key on the keyboard.
3. Select Row 6.

3 | Jan Feb Mar
New York 22,000 29,000 19,000
5 |Los Angeles 42,000 39,000 43,000
lLondon 18,000 20,000 22,000
7 |Paris 35,000 26,000 31,000
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First Quarter Sales and
Profit-4

Lesson 2-7: Select non-
contiguous cell ranges and
view summary information

Non-contiguous is a very impressive word! It simply means a range of
cells that is split across two blocks of cells in different parts of the
worksheet.

Non-contiguous ranges can be selected using both the mouse and
keyboard. The keyboard method may seem a little involved at first but
you’ll find it much faster once you have the hang of it.

1 Open First Quarter Sales and Profit-4 from your sample files
folder (if it isn’t already open).

2 Select the contiguous range B4:D8 with the keyboard.

When you need to select a contiguous range with the keyboard
here’s how it’s done:

1. Use the arrow keys on the keyboard to navigate to cell B4
2. Hold down the <Shift> key on the keyboard

3. Still holding the <Shift> key down, use the arrow keys on the
keyboard to navigate to cell D8

The contiguous range B4:DS8 is selected.

[ TN [ S - Y
1 |Sales and Profit Report - First Quarter 2008
2
3 Jan Feb Mar Total
New York 22,000 29,000 19,000 70,000
Los Angeles 42,000 39,000 43,000
London 18,000 20,000 22,000
Paris 35,000 26,000 31,000
Munich 12,000 15,000 13,000
| 9 | USA Sales 64,000

3 Select the non-contiguous range B4:B8,D4:D8 using the
mouse.

1. Select the range B4:B8.
2. Hold down the <Ctrl> key and select the range D4:D8.
The non-contiguous range B4:B8,D4:D8 is selected:

B~ [ s ] c¢ [p ] e ]

1 [Sales and Profit Report - First Quarter 2008

3 Jan Feb Mar Total
New York 22,000 29,000 | 19,000 | 70,000
Los Angeles 42,000 39,000 43,000
London 18,000 20,000 22,000
Paris 35,000 26,000 31,000
Munich 12,000 15,000 13,000

9 (USA Sales 64,000

L 1
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4 Select the same non-contiguous range with the keyboard.

This is a little more involved than using the simple
<Shift>+<Arrow keys> method used earlier.

Here’s how it’s done:

Use the arrow keys on the keyboard to navigate to cell B4
Press the <F8> key (it is on the very top row of your keyboard)
Use the arrow keys to navigate to cell B8

Press <Shift>+<F8>

Use the arrow keys to navigate to cell D4

Press <F8>

Use the arrow keys to navigate to cell D8

® N o @ o » o=

Press <Shift>+<F8> one last time

The non-contiguous range B4:B8,D4:D8 is selected:

BE o~ [Toe ] ¢ e ] e

1 |Sales and Profit Report - First Quarter 2008

2

3 Jan Feb Mar Total
New York 22,000 29,000 | 19,000 | 70,000
Los Angeles 42,000 39,000 43,000
London 18,000 20,000 22,000
Paris 35,000 26,000 31,000
Munich 12,000 15,000 13,000

l 9 | USA Sales 04,000

5 Obtain a total sales figures for January and March using the
status bar.

The status bar contains summary information for the currently
selected range.

v | Average 25,700

¥ count 10 Look at the bottom right of your screen. You can see the average
N _ sales and total sales (sum of sales) for January and March:
Mumerical Count

v | Minimum 12,000 Average: 25,700 Count: 10 Sum: 257,000

v | Maximum 43,000

v || Sum 357000 6 View the Maximum and Minimum sales for January and

Bl view Shortcuts March using the status bar.

v || Zoom 100% Right-click the status bar and click Maximum and Minimum on the

% ;nnm lider pop-up menu (see sidebar).

The status bar now also displays Maximum and Minimum values.

Average: 25,700 Count: 10 Min: 12,000 Max: 43,000 Sum: 257,000

7 Close the workbook without saving.
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Lesson 2-8: AutoSelect a
range of cells

When data is arranged in a block (as it is in the Sales and Profit Report) it
is referred to as a range (in previous versions of Excel it used to be called
a database or list).

You will often want to select a row or column of cells within a range, or
even the entire range.

You can select ranges by using any of the techniques covered so far but
this could be very time consuming if the range encompassed thousands
of rows and columns.

In this lesson you’ll learn how to select range rows, range columns and
entire ranges with a few clicks of the mouse.

1 Open Sales Report from your sample files folder.

This report contains a range of cells. The range is the block of cells
from A3 to E19.

A B c D E f

1 ‘Weekly Sales Report

2

3 |invoice No Date Customer Country  Total

4 10918 10 March 2008 Bottom-Dollar Markets Canada 1,700.81

5 10917 10 March 2008 Romero y tomillo Spain 439.92

6 10926 10 March 2008 Ana Trujillo Emparedados y helados Mexico 604.42

7 10929 11 March 2008 Frankenversand Germany = 1,380.33

8 10934 11 March 2008 Lehmanns Marktstand Germany 587.50

9 10939 11 March 2008 Magazzini Alimentari Riuniti Italy 749.05

10 10939 11 March 2008 Magazzini Alimentari Riuniti Italy - 7439.05 =
11 10925 12 March 2008 Hanari Carnes Brazil 558.29

12 10944 12 March 2008 Bottom-Dollar Markets Canada 1,204.75

13 10923 12 March 2008 La maison d'Asie France 879.83

14 10937 13 March 2008 Cactus Comidas para llevar Argentina 757.64

15 10947 13 March 2008 B's Beverages UK 258.50

16 10933 13 March 2008 Island Trading UK 1,081.71

17 10938 14 March 2008 QUICK-Stop Germany  3,209.95

18 10949 14 March 2008 Bottom-Dollar Markets Canada 5,195.85

19 10945 14 March 2008 Morgenstern Gesundkost Germany 287.88 2
20 k

21 | Thsi report excludes sales to Asia and South Africa. Range
R Sheet1 . Sheet? .~ Sheet3 ' #J ] m B |

2  Select all cells within the range to the right of cell A7.
1. Clickin cell A7 to make it the active cell.

2. Hover over the right hand border of cell A7 until you see the
four headed arrow cursor shape.

7 109 2‘3%1

8 10924 11

3. When you see this cursor shape hold down the <Shift> key
and double-click.

All cells to the right of A7, but within the range, are selected.

7 10929 11 March 2008 Frankenversand Germany  1,380.33

Sales Report
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note

Other ways to
AutoSelect arange

Using the keyboard.

Here’s how you would select
the entire range in the Weekly
Sales Report (excluding the
header row) using the keyboard
method.

Make cell A4 the active cell by
navigating to it with the
<Arrow> keys.

1. Press: <Ctrl>+<Shift>+
<DownArrow>

Cells A4:A19 are selected.

2. DPress: <Ctrl>+<Shift>+
<RightArrow>

The entire range (excluding
the header row) is selected.

Using shortcut keys.

The shortcut keys method is the
fastest way to select the entire
range including the header row.

1. Click anywhere inside the
range.

2. DPress: <Ctrl>+<A>

The entire range (including
the header row) is selected.

From the Ribbon.

The Ribbon method isn’t as
powerful as the other methods
but does provide a way to select
the current range (described as
the region in the dialog).

Make sure that the active cell is
within the range.

1. Click:

Home->Editing>
Find & Select>
GoTo Special...

The GoTo Special dialog is
displayed.

2. Click the Current Region
option button and then
click the OK button.

The entire range (including the
header row) is selected.

Select all cells within the range except the header row.
1. Click in cell A4 to make it the active cell.

2. Hover over the right hand border of cell A4 until you see the
four headed arrow cursor shape.

4 lﬂﬂlﬁ{%l[

5 10917 44

3. When you see this cursor shape hold down the <Shift> key
and double-click.

All cells to the right of cell A4, but within the range, are
selected.

4. Hover over the bottom border of the selected range until you
see the four headed arrow cursor shape.

Customer
Narch 2008 Bottom-Dollar Markets
flarch 2008 Romero yﬁﬂilln

5. When you see this cursor shape hold down the <Shift> key
and double-click.

The entire range (except the header row) is selected.

A B L D E '
1 |Weekly Sales Report [ ]
2
3 Invoice No Date Customer Country  Total
4 10918 10 March 2008 Bottom-Dollar Markets Canada 1,700.81
5 10917 10 March 2008 Romero y tomillo Spain 429.92
6 10926 10 March 2008 Ana Trujillo Emparedados y helados Mexico 604.42
7 10929 11 March 2008 Frankenversand Germany  1,380.33
8 10934 11 March 2008 Lehmanns Marktstand Germany 587.50
9 10939 11 March 2008 Magazzini Alimentari Riuniti Italy 749.05
10 10939 11 March 2008 Magazzini Alimentari Riuniti Italy - 749.05 =
11 10925 12 March 2008 Hanari Carnes Brazil 558.29
12 10944 12 March 2008 Bottom-Dollar Markets Canada 1,204.75
13 10923 12 March 2008 La maison d'Asie France 879.83
14 10937 13 March 2008 Cactus Comidas para llevar Argentina 757.64
15 10947 13 March 2008 B's Beverages UK 258.50
16 10933 13 March 2008 Island Trading UK 1,081.71
17 10938 14 March 2008 QUICK-Stop Germany  3,209.95
13 10943 14 March 2008 Bottom-Dollar Markets Canada 5,195.85
19 10945 14 March 2008 Morgenstern Gesundkost Germany 287.88 B
20
21 Thsi report excludes sales to Asia and South Africa. B
4 4+ | Sheetl ~Sheet? Sheetd -~ ¥1 ] B}

You can also use this technique to select cells to the left of the
active cell or above the active cell.

Close the workbook without saving.
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Lesson 2-9: Re-size rows and
columns

1

note

Why are you calling
the pound sign a
hash?

You like potato and I like potahto,

You like tomato and I like tomahto; 3
Potato, potahto, tomato, tomahto!

Let’s call the whole thing off!

Song lyric by George Gershwin,
American Composer (1898-1937)

In the USA and Canada the
hash symbol is called the
pound sign or the number
sign.

In different USA/Canada
regions the single symbol has
different names because it can
be used to denote a number (as
in contestant #5) or as a weight

(as in 3# of butter). 4

Throughout this book I will
refer to the # as a hash because
that is the term used in most
other English speaking
countries.

First Quarter Sales and
Profit-4

Open First Quarter Sales and Profit-4 from your sample files
folder (if it isn’t already open).

Notice that columns B, C, D and E are far too wide for their
contents. It would be useful to make them narrower to keep the
worksheet compact.

Re-size column B so that it is just wide enough to contain the
January sales figures.

Hover over the line separating the letters B and C until you see the
re-size cursor shape:

B+ C

When you see this shape, keep the mouse still and click and drag
to the left. Column B will re-size as you drag. Make it narrower so
that the values just fit in the column. Notice that the column width
in points and pixels are displayed as you drag (one point = 1/72
inch).

Width: 8.86 (67 pixels)
A B ¢ C D

1 |Salesand F‘rDEit Repurt-éFirSt Quarter 2008
2

3 Jan Feb Mar
4 |NewYork | 22,000 : 29,000

19,000

Re-size column B so that it is too narrow to contain the
January sales figures.

Notice that when the column isn’t wide enough to contain the
contents, hash signs are shown instead of values (if you're used to
hashes being called pound signs or number signs see the sidebar).

A B C D
1 Sales and Profit Report - First Quarter 2008
2
3 Jan Feb Mar
4 New York st 29,000 15,000

Automatically re-size column B so that it is a perfect fit for
the widest cell in the column.

Hover over the line separating the letters B and C until you see the
re-size cursor shape:

B+ C

When you see this shape, double-click to automatically re-size
column B.
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note

Other ways to re-size
rows and columns

You can also re-size rows and
columns using the Ribbon.

Click Home—>Cells>Format.

A drop-down menu appears.

— — GOIL &L FIng
|;-| FarmatT\ 27 Filter~ Sele
Loy

Cell Size

:$|: Row Height...
AutoFit Row Height

1 Column Width...
AutoFit Column Width

Default Width...

You can use the Row Height and
Column Width settings to set the
row or column to a specific
number of points (a point is
1/72 of an inch).

You can also use the AutoFit
Row Height and AutoFit Column
Width options to automatically
size the row or column (you
achieved this more efficiently
with a double-click in the
lesson).

Default Width... often confuses
as it doesn’t appear to work.
This is because it re-sets all
columns to default width except
those that have already been re-
sized.

note

Making several
columns or rows the
same size.

Sometimes you will want to
make several columns exactly
the same width.

To do this, select the multiple
columns and then click and
drag the intersection of any of
the selected columns. This will
make each of the columns
exactly the same width.

5

8

Automatically re-size every column in the worksheet in one
operation.

1. Select every cell in the workbook by clicking the select all
button in the top left corner of the worksheet (you can also do
this by clicking in any blank cell and then pressing
<Ctrl>+<A>).

By

2. Hover over the intersection of any two columns until you see

o

and then double-click.

the re-size cursor shape
Every column is now perfectly sized.

Notice that Auto-resize has done its job rather too well. Column A
is now wide enough to accommodate all of the text in cell Al.

A B C
1 Sales and Profit Report - First Quarter 2008

Automatically re-size column A so that it is only wide enough
to contain the longest city name (Los Angeles).

A B C D E
Sales and Profit Report - First Quarter 2008

MNew York 22,000 29,000 15,000 70,000

1
2
3 Jan Feb Mar Total
4
5 |Los Angeles 42,000 35,000 43,000

1. Select cells A4:A9.
2. Click Home~>Cells>Format—=> AutoFit Column Width.

This time the column is automatically sized so that it is wide
enough to contain all of the text in the selected cells.

Notice that the text has spilled over from cell Al into the adjoining
columns B, C, D and E. This always happens when a cell contains
text and the adjacent cells are empty.

Manually size row 3 so that it is about twice as tall as the
other rows.

Do this in exactly the same way you re-sized the column but, this
time, hover between the intersection of rows 3 and 4 until you see
the re-size cursor shape, and then drag downwards.

1 Sales and Profit Report - First Quarter 2008

1 Height: 30.00 (40 pixels) |

Tan Feb Mar
_i_ MNew York
Los Angeles

22,000 29,000
42,000 39,000

Auto-resize row 3 so that it is the same size as the other

rows again.

19,000
43,000
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First Quarter Sales and
Profit-4

Lesson 2-10: Use AutoSum to
sum a non-contiguous range

In Lesson 2-7: Select non-contiguous cell ranges and view summary
information, you learned how to view the sum of January and March sales
using the status bar. But how can you put that value onto the worksheet?

Now that you have the hang of selecting non-contiguous ranges you can
use this in conjunction with your AutoSum skills to create a formula that
will calculate the total of a non-contiguous range.

1

2

5

Open First Quarter Sales and Profit-4 from your sample files
folder (if it isn’t already open).

Enter the text Jan/Mar Sales in cell A10 and press the
<Tab> key.

The active cell moves to cell B10.

Re-size column A so that it is wide enough to contain the
text.

1. Hover over the line separating the letters A and B until
you see the re-size cursor shape:

A + B

2. When you see this shape, keep the mouse still and click
and drag to the right. Column A will re-size as you drag.
Make it wider so that the words Jan/Mar Sales comfortably
fit in the column:

3 Jan Feb Mar T=
4 MNew York 22,000 29,000 19,000

5 Los Angeles 42,000 39,000 43,000

6 London 13,000 20,000 22,000

7 Paris 35,000 26,000 31,000

8 Munich 12,000 15,000 13,000

9 |USA Sales 64,000

10 Jan/Mar Sales 1 .
4 4 » M| Sheetl ~Sheet? ~ Sheet3 [N I | 0
Ready Calculate | P& ||E|ﬁ| | 100% @—@ @ =

Click Home—>Editing—> @ (the AutoSum button).

An AutoSum appears in cell B10 but it isn't anything like what we
want yet. It guesses that we simply want to repeat the value in the
USA Sales cell.

& |Munich 12,000 15,000 13,000

9 |UsA sales P ea,000 )

10 |Jan/Mar Sales |=SUM{E} |

11 | SUM(numberl, [number?], ...) |

M 4 » M| Sheetl -~ Sheet2 . Sheet3 [JIL__u___| ]
Point  Calculate | 23 ElE TN )

Select the range B4:B8 with the mouse.
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7

8

Hold down the <Ctrl> key and select the range D4:D8 with
the mouse.

Notice that the non-contiguous range B4:B8,D4:D8 is shown in the
AutoSum’s formula:

Oa H ) - [ 5 First Quarter Sales and Pro... M _ = X
A

- Horrl Inse | Page| Fcurnl Datzl F{e'\ri-| Viw| Dewl Add-|@ - B X

| SUM ~ (0 % « Jjx| =SuM(B4:B8,D4:D8) v

A B C 8] L

Sales and Profit Report - First Quarter 2008

Jan Feb Mar 14
New York 1 22,000 1 29,000 ) 19,000 1 |
Los Angeles E 42,000 E 39,000 E 43,000 E
London E 18,000 20,000 E 22,000 |
Paris ! 35,000 | 26,000 | 31,000 |
Munich b...12000{ 15000} 13,000

Usa sales 64,000

1
2
3
4
5
6
7
8
9
Eljan,’MarSales |=SUM(B-1:BS,D4:DS}
11

[ SUM{numberl, [number?], [number3], ...) ]

4 4 k K
Calculate | T4 |

Point

Press the <Enter> key or click the AutoSum button @
again to view the sales for January and March in cell B10.

-

Oa H ¥y - [ 5 First Quarter Sales and Pro..h  _ = X
[

- Horrl Insel Pagtl Foml DatE| Revi |Vieu| De'vtl Add |® - B X
| 13 - (> % | ¥

A B C D

1 Sales and Profit Report - First Quarter 2008

X

3 Jan Feb Mar =
4 |New York 22,000 29,000 19,000

5 LosAngeles 42,000 39,000 43,000

6 London 18,000 20,000 22,000

7 Paris 35,000 26,000 31,000

2 |Munich 12,000 15,000 13,000

9 UsA Sales 64,000

10 Jan/Mar Sales 257,000

4 4 + M| Shestl  Sheet? - Sheet3 [ |
Ready Calculate | =4 | 00

L

Save your work as First Quarter Sales and Profit-5.
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First Quarter Sales and

Click
Here

- Ay &
3. 27 &
i Sort & Find &
L7 Filter~ Select~
Editing

Lesson 2-11: Use AutoSum to
quickly calculate averages

Excel’s AutoSum feature isn’t only restricted to addition. It is also able to
compute averages and maximum/minimum values.

In this lesson we’ll use AutoSum to calculate the average sales for each
month.

1 Open First Quarter Sales and Profit 5 from your sample files
folder (If it isn’t already open).

2  Delete cells E3:EA4.

Select cells E3 and E4 and press the <Delete> key on your
keyboard.

3 Type the word Average in cell E3 and press the <Enter>
key.

The cursor moves to cell E4:

C D E

3  Feb Mar Average
4 29,000 19,000 I .I

4 Use AutoSum to create a formula that will show the Average
New York sales.

1. Click Home->Editing> AutoSum ->Drop down arrow (see
sidebar).

A drop down menu is displayed showing all of the different
ways in which AutoSum can operate upon a range of cells:

2. Click Average.

Ay &
X Sum
Average
Count Mumbers
Max
Min

Mare Functions...

3. Excel generates an Average function and inserts the cell range
B4:D4. This is exactly what we want:

Average
—AVERAGE(EERER)

AVERAGE(numberl, [numberZ], ...)

Profit-5

4. Press the <Enter> key or click the AutoSum button again
to see the average sales for New York:

3 Jan Feb Mar Average
4 |NewYork 22,000 29,000 19,000 23,333

5 Type the word Maximum in Cell F3 and then press the
<Enter> key.

6 Use AutoSum to create a formula in cell F4 that will show the
Maximum New York Sales for this period.
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tip
Another way to bring back the
blue box showing a range is to

click the range in the Formula
bar.

1.

Place an AutoSum in cell F4 but this time, choose Max from the

drop-down menu.

This time we have a small problem. AutoSum is including the

average value (23,333) in the calculation.

lan Feb

Mar Average Naximum

I 22,000 29,000 19,000

23,333 | =MAX(

Select cells B4:D4 with the mouse

The marquee corrects and the average value in cell E4 is no

longer included.

MNew Yurk[ 22,000 29,000 IE,DDDI 23,333

=MAX(B4:D4)|

Notice that the Max function is now working with the range

B4:D4.

Press the <Enter> key or click the AutoSum button EI once
more to see the maximum sales the New York office managed

during the first quarter of the year:

3

4 Mew York

Jan

Feb Mar

22,000 29,000 15,000

Average Maximum

23,333

29,000

are included in the Sales total.

Change the words USA Sales in cell A9 back to Sales and
press the <Tab> key.

Press the <F2> key on the keyboard (or double-click cell B9)
to bring back the marquee (shown as a blue box).

Adjust the marquee using click and drag so that all offices

Notice that there is a small blue spot on each corner of the range.
These are called sizing handles.

1.

10 Save your work as First Quarter Sales and Profit-6.

Hover the mouse cursor over the bottom right (or bottom left)
sizing handle until the cursor shape changes to a double
headed arrow. It is really important that you see the double
headed arrow and not the four headed arrow or white cross.

4 Mew York
5 |Los Angeles
6 |London

‘ 22,000 |
42,000
"y

18,000

When you see the double headed arrow click and drag with
the mouse down to cell BS.

Press the <Enter> key or click the AutoSum button again.

7 Paris
8 Munich
9 Sales

35,000
12,000
123,000

© 2017 The Smart Method Ltd
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important

Formulas automatically
recalculate whenever any of the
cells in the formula change.

For example: If you were to
change the Paris sales to 45,000
this would cause cell B9 to re-
calculate to 139,000. Because B9
has changed this would, in
turn, cause the profit to re-
calculate to 56,000.

Lesson 2-12: Create your own
formulas

The AutoSum tool is very useful for quickly inserting Sum(), Average(),
Count(), Max() and Min() formulas into cells. Many Excel users never get
any further with their formulas than this.

In this session we’ll create our own formulas without the use of
AutoSum. You'll be amazed at how easy it is.

1

2

w

First Quarter Sales and
Profit-6

Open First Quarter Sales and Profit-6 from your sample files
folder (if it isn’t already open).

Select cells A10:B10 and press the <Delete> key once.
The previous contents of cells A10:B10 are removed.
Type the word Costs into cell A11 and Profit into cell A12.

Type the value 83,000 into cell B11 and press the <Enter>
key to move down to cell B12.

11 Costs
12 |Profit

83,000

Enter a formula into cell B12 to compute the profit made in
January.

1. Type: =B9-B11 into cell B12
2. Press the <Enter> key.
The profit for January is displayed:

9 Sales 129,000
10

11 Costs 83,000
12 Profit 46,000

Enter the formula again using a better technique.

The method that you have just used to enter the formula works
just fine but it isn’t the best method. Sooner or later you will make
a mistake. For example you could easily type B8:B11 resulting in
an incorrect answer.

To eliminate such errors you should always select cell references
visually rather than simply type them in. You can visually select
cells using either the mouse or the keyboard. First we’ll use the
mouse method.

1. Clickin cell B12 and press the <Delete> key on the keyboard to
clear the old formula.

2. Press the equals <=> key on the keyboard.
3. Click once on the value 129,000 in cell B9.
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important

The Excel Operators

Name Example

4

*

/
%

Addition
Subtraction
Multiplication
Division
Percent

Exponentiation

1+2
7-5
6*3
15/5
25%
472

4. Press the minus <-> key on the keyboard.
5. Click once on the value 83,000 in cell B11.
6. Press the <Enter> key on the keyboard.

If you followed the above steps carefully you will see that you
have created the same formula but with a much lower possibility
of making a mistake.

Enter the formula again using the visual keyboard technique.

The very best Excel experts hardly use the mouse at all. You waste
valuable seconds every time you reach for the mouse.

Here’s the expert technique of visual selection via keyboard:

1. Use the arrow keys to navigate to cell B12 and then press the
<Delete> key on the keyboard to clear the old formula.

2. Press the <=> key on the keyboard.

3. Press the <Up Arrow> key three times to move to cell B9.
4. Press the <-> key on the keyboard.

5. Press the <Up Arrow> key once to move to cell B11.

6. Press the <Enter> key on the keyboard.

Enter a formula that uses the multiplication operator.

This employer is very generous and pays the staff ten percent of all
profits as an incentive bonus.

In cell A13 type the words 10% Bonus and then press the <Tab>
key on the keyboard to move to cell B13.

Enter a formula that uses the multiplication operator.

The multiplication operator is not an X as you might expect but an
asterisk (¥). The other Excel operators are shown in the sidebar.

You need to press <Shift>+<8> to enter an asterisk. If you are using
a full size keyboard with a numeric keypad at the right-hand side
you can also use the numeric keyboard’s <X> key.

Whichever key you use you'll still see an asterisk in the formula.

Use either the mouse click technique or the visual keyboard technique
to enter the formula shown below into cell B13 and then press the
<Enter> key to see how much bonus was earned:

11 |Costs 83,000
12 |Profit [ 26,000
13 |10% Bonus |=812*.1) |

11 |Costs 83,000
12 |Profit 46,000
13 |10% Bonus 4,600

10 Save your work as First Quarter Sales and Profit-7.
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trivia

The feature that Excel uses to
help you out with function calls
first made an appearance in
Visual Basic 5 back in 1996 and
had the wonderful name:
IntelliSense. The Excel

implementation is called
Formula AutoComplete.

In 1996 I was working in
Switzerland developing a ski-
school management
application. I was extremely
impressed by how easy
IntelliSense made my job. I
didn’t have to remember
hundreds of function names
any more.

I was even slightly worried that
just about anybody could now
program (but, of course, I was
wrong).

Recently I was in London being
driven by a Hackney cab driver
(Hackney cab drivers know
every shortcut and back street
in London). He was worried
that Satellite Navigation would
now mean that anybody could
become a London cabbie.

Of course, he really had
nothing to worry about either!

note

Enabling and
disabling
AutoComplete.

As with so many other features,
Microsoft allows you to turn
this very useful feature off.

You’d never want to do this but
you may work on a machine
that has had Formula
AutoComplete switched off
and you need to turn it on
again.

Click Office->Excel
Options>Formulas and make

sure that the Formula
AutoComplete box is checked.

First Quarter Sales and
Profit-7

Lesson 2-13: Create functions
using Formula AutoComplete

1

2

Open First Quarter Sales and Profit-7 from your sample files
folder (if it isn’t already open).

Type the words USA Sales into cell A15 and European
Sales into cell A16.

Notice that the text European Sales spills over into column B
because column A isn’t wide enough to contain it.

Re-size column A so that it is wide enough for the words
European Sales to fit within the column.

You learned how to do this in: Lesson 2-9: Re-size rows and columns.

A B
15 |USA Sales
16 European Sales

Click into cell B15 and type =S into the cell.

Something amazing happens:

15 |USA Sales =5 |

16 |European Sales | (/&) -
17 () SECOMND

18 () SERIESSUM |
1 Lo

A list drops down showing every function in the Excel function
library beginning with S. This is a great new feature for Excel 2007
that Microsoft call Formula AutoComplete (if AutoComplete didn’t
display as expected see the sidebar).

You've already encountered the Sum(), Average() and Max()
functions courtesy of AutoSum.

You may be pleased (or dismayed) to know that there are over 300
functions in the Excel function library. The good news is that most
untrained Excel users only ever get to understand Sum() and
Average()!

When you typed =S Excel listed all functions beginning with S.
Continue typing: =SU.

Notice that the list now only shows functions beginning with SU
and look... there’s the SUM() function we need three down in the
list.

You could simply click on it with the mouse but let’s behave like
an Excel pro and do it with the keyboard.

Press the <Down Arrow> key twice to move the cursor over
the SUM function.

The Sum function now has a tip telling you what the function does:
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note

The syntax box

The Syntax box tells you what
arguments (sometimes called
parameters) the function needs.
The first argument has no
square brackets meaning that
you can’t leave it out. The
argument in square brackets is
optional.

For such a simple function as
SUM() the syntax box is hardly
needed but later we’ll discover
functions that require several
arguments and then the syntax
box will be invaluable.

A B
14
15 USA Sales
16 European Sales

64,000
65,000

10

11

15 USA Sales [=su

16 European Sales | (f) SUBSTITUTE
17 #) sUBTOTAL

18 ®

19 | Adds all the numbers in a range of cells

Display detailed information about the SUM() function.

The tip tells you a little about the SUM() function but to get the full
story press the <F1> key while SUM is still highlighted in the
dropdown list:

The Excel help system opens showing detailed help for the SUM()
function.

Read the help text if you are interested and then close the help
window.

Notice that Excel has now left you with only =SU in the cell.
Complete the formula by typing M(

[=sum( |
‘ | SUM{numberl, [number?], ...) |

Notice that a little box has appeared beneath the function call. This
is the Syntax (see sidebar for more information).

Select the cells that you need to sum (cells B4:B5) with the
mouse or keyboard.

If you want to be a real pro you should select them with the
keyboard. To do this:

1. Press the <Up Arrow> key repeatedly until you reach cell B4.

2. Hold down the <Shift> key and press the <Down Arrow> key
once to select cells B4:B5.

Type a closing bracket to complete the formula and then
press the <Enter> key.

The total USA sales are displayed in cell B15.

Use the same technique to create a SUM() function in cell
B16 to show the total European sales (cells B6:B8).

1. Click in cell B16.
2. Type=SU.

3. Press the <Down Arrow> key twice to move the cursor over
the SUM function.

4. Press the <Tab> key to automatically enter the SUM function
into cell B16.

5. Select the range B6:B8.

6. Type the closing bracket followed by the <Enter> key. The
formula should now be: =SUM(B6:B8).

Save your work as First Quarter Sales and Profit 8.
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Lesson 2-14: Use AutoFill for
text and numeric series

1

2

note

If you don’t see the
AutoFill handle
somebody has
switched it off

It's almost certain that AutoFill

will be enabled on any

computer that you work on. It 4
is such a useful feature that you
wouldn’t want to disable it.

If you don’t see the AutoFill
handle (the black spot on the
bottom right hand corner of the
active cell) it’s because
somebody has switched
AutoFill off.

Bring it back like this:

Click Office—>Excel
Options>Advanced

In the first section (Editing
Options) check the box next to
Enable fill handle and cell drag
and drop.

First Quarter Sales and
Profit-8

Open First Quarter Sales and Profit-8 from your sample files
folder (if it isn’t already open).

Delete the text Feb and Mar from cells C3:D3.

Select cells C3:D3 and then press the <Delete> key on your
keyboard.

Make B3 the active cell.

Notice that there is a black border around the cell and a black spot
on the bottom right-hand corner. This is the AutoFill handle. If you
don’t see it, refer to the sidebar.

Autofill
[ 1 Handle

Hover over the AutoFill handle with your mouse until the
cursor shape changes to a black cross.

Many of my students have great difficulty with this when they try
it for the first time.

e  You don’t want the four-headed arrow: 'I‘ — that would move
the cell.

e  You don’t want the white cross: {P — that would select the
cell.

e You want the black cross: + — the AutoFill cursor.

Jlan
+
When the black cross cursor is visible hold down the mouse
button and drag your mouse to the right to AutoFill the other
months: Feb and Mar.

Jan Feb

Mar

o

22,000 29,000 0o

kar

Notice the tip that appears as you drag, previewing the month that
will appear in each cell.

In cell A18 type Monday and AutoFill down to cell A24 to
show the days of the week.

(If you are not using an English language version of Excel you will
need to type Monday in your own language).

In cell B18 type the number 1 and in cell B19 type the
number 2.
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tip
You don’t have to enter two

numbers if you want to create a
numeric range.

If you simply type a number
into a cell and then AutoFill
while holding down the <Ctrl>
key you will automatically
generate sequential numbers.

10
11

12

13

14

15

Select cells B18 and B19.

1

0 2

AutoFill down to B24 to create sequential numbers:

18 |Monday 1
19 |Tuesday 2
20 Wednesday 3
21 |Thursday i |

In cell C18 type 9 and in cell C19 type 18.

Select cells C18 and C19.
9
o8
|
AutoFill down to B24 to create the nine times table.
18 Monday 1 g
19 Tuesday 2 18

20 Wednesday 3 27

Use AutoFill to create sequential dates.

1. Type 01-Jan-08 into cell D18.

2. Type 02-Jan-08 into cell D19.

3. Select Cells D18:D19.

4. AutoFill down to D24 to create sequential dates.
Use AutoFill to quickly copy values.

Sometimes you will want to duplicate the value from one cell into
many others to the right of, left of, beneath, or above the active cell.

When a cell containing text is the active cell and it isn’t defined as a
fill series (the built-in fill series are days of the week and months of
the year), AutoFill will simply duplicate the contents of the cell:

Type the text Adjusted into cell E18 and then AutoFill it down as
far as cell E24.

The same text is now shown in each of the cells:

18 \Monday 1 9 01-lan-08 Adjusted
15 |Tuesday 2 18 02-Jan-08 Adjusted
20 Wednesday 3 27 03-lan-08 Adjusted
21 |Thursday 4 36 04-Jan-08 Adjusted
22 |Friday 5 45 05-Jan-08 Adjusted
23 |Saturday 6 54 06-Jan-08 Adjusted
24 |Sunday 7 63 07-Jan-08 Adjusted

Save your work as First Quarter Sales and Profit-9.
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First Quarter Sales and
Profit-9

Lesson 2-15: Use AutofFill to
adjust formulas

AutoFill can save you a lot of time when extending or copying text and
number ranges. But the story’s not over yet.

AutoFill’s ability to copy and adjust formulas is one of the most powerful
tools in Excel’s impressive armory.

1 Open First Quarter Sales and Profit 9 from your sample files
folder (If it isn’t already open).

2 Consider the formula in cell B9.

Click onto cell B9 and view the formula displayed in the formula
bar (the formula bar is at the top right of the screen grab below).

B9 - fe | =sum(B4:Bs)
A B C D E
1 Sales and Profit Report - First Quarter 2008
2
3 Jan Feb Mar Average
4 MNew York 22,000 29,000 13,000 23,333
5 |Los Angeles 42,000 39,000 43,000
& London 15,000 20,000 22,000
7 |Paris 35,000 26,000 31,000
8 |Munich 12,000 15,000 13,000
9

Sales 129,000 I

o
=]

The formula is =SUM(B4:B8). AutoSum created it for us in:
Lesson 2-3: Use AutoSum to quickly calculate totals. The formula uses
the SUM() function to add together the values in the range B4:BS.

Think about the formula that would work in cell C9 (the total sales
for February). It would be: =SUM(C4:C8). Similarly the formula
that would work in cell D9 (the total sales for March) would be
=SUM(D4:D8).

As we move to the right all that is needed is to increment the letter
for each cell reference in the formula and we’ll get the right answer
every time.

Now AutoFill is very clever and realizes this. When we AutoFill a
cell containing a formula to the right, AutoFill increments the
letters in each cell reference.

Most of the time that is exactly what we want.

There’s also a way to fine-tune the way in which AutoFill adjusts
cell references allowing you to implement some more advanced
AutoFill techniques. While this is beyond the scope of this Basic
Skills course, it is covered in-depth in the Essential Skills book in
this series (in Lesson 3 12: Understand absolute and relative cell
references, and Lesson 3 13: Understand mixed cell references).
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E F
Average Maximum
23,333 29,000
41,333 43,000
20,000 22,000
30,667 35,000
13,333 15,000

AutoFill cell B9 to the right as far as cell D9.

You may see a row of hashes in Cell C9. This is because the value
is too wide to fit in the cell. If this is the case, AutoFit the column
using the skill learned in: Lesson 2-9: Re-size rows and columns.

The correct answers for Feb and Mar sales are shown on the
worksheet. Click on the Feb total cell (C9) and look at the formula
in the formula bar.

s - fe | =sum(ca:cs)

A B c D E
3 Jan Feb Mar Average
4 MNew York 22,000 29,000 19,000 23,333
5 |Los Angeles 42,000 39,000 43,000
& London 18,000 20,000 22,000
7 |Paris 35,000 26,000 31,000
8 Munich 12,000 15,000 13,000
9 Sales 129,000 | 123,000 .I 128,000

Wi

You can see that AutoFill has done its work perfectly, creating a
sum of the values in cells C4:C8. Our five branches have sold
exactly the same amount in both January and February, but a little
less in March.

Consider the formula in cell E4.

Click onto cell E4 and view the formula displayed in the formula
bar.

E4 - [ fe | =AVERAGE(B4:D4)
A B C D E

3 Jan Feb Mar Average |
4 MNew York 22,000 29,000 15,DDDI 23,333 .I
5
]

Los Angeles 42,000 39,000 43,000
Londaon 18,000 20,000 22,000

The formula is =AVERAGE(B4:D4). AutoSum created it for us in:
Lesson 2-11: Use AutoSum to quickly calculate averages.

Think about the formula that would work in cell E5 (the average
sales for Los Angeles). It would be: =Average(B5:D5). Similarly the
formula that would work in cell E6 (the average sales for London )
would be =Average(B6:D6).

As we move downward all that is needed is to increment the
number for each cell reference in the formula. This is exactly what
AutoFill will do.

AutoFill cell E4 down to E8 to see the Average sales for
each branch.

AutoFill cell F4 down to F8 to view the maximum sales for
each branch.

Save your work as First Quarter Sales and Profit-10.
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Lesson 2-16: Use AutokFill
options
Sometimes AutoFill begins to misbehave and actually gets in the way of

efficient work by wrongly anticipating what you need.

1 Open First Quarter Sales and Profit-10 from your sample
files folder (If it isn’t already open).

2  Incell F18 type the date 1-Jan-2009.
3 AutoFill down as far as cell F24.

The cells are populated with sequential dates:

A B C D E F
18 Monday 1 9 01-lan-08 Adjusted  01-Jan-09
19 Tuesday 2 18 02-lan-08 Adjusted  02-Jan-09
20 Wednesday 3 27 03-Jan-08 Adjusted  03-Jan-09
21 Thursday 4 36 04-lan-08 Adjusted  04-Jan-09
22 Friday 5 45 05-Jan-08 Adjusted  05-Jan-09
23 Saturday 6 54 06-Jan-08 Adjusted  06-Jan-09
24 Sunday 7 63 07-lan-08 Adjusted  07-Jan-09

4 In cell G18 type the date 31-Mar-2009.
5 AutoFill down as far as cell G24.

At some time you'll need to add transaction dates to a worksheet
and will have four or five entries with the same date.

AutoFill is perfect for eliminating the need to re-type the date for
each transaction, but its insistence upon incrementing the date
every time could be very frustrating.

Fortunately we can change the default behavior.

I-5
6  Click the Auto Fill Options Smart Tag =* at the bottom right
corner of the filled cells.

03-Apr-09
04-Apr-09
05-Apr-09
06-Apr-09
& -
C éopy' Cells '
(' Fill Series [k
) Fill Eormatting Only
O Fill Without Formatting
O Fill Days
O Fill Weekdays
) Fill Months
‘ ' Fill Years

First Quarter Sales and
Profit-10
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7 Click Copy Cells to tell AutoFill not to increment the date.

The Fill Formatting option is beyond the scope of this Basic Skills
book but is covered in-depth in the Essential Skills book in this
series (in Session Four: Making Your Worksheets Look Professional).

Here’s what the other options will do:

Copy Cells  Fill Series  Fill Days  Fill Weekdays Fill Months Fill Years
This is what The default The date Because 3 April | Normally this would The same
we just did. for dates that | increments | 2009 is a Friday show the same day calendar day
. . | include the by one day | the weekend number for each is shown for
The first cell is . . .
. day. at a time. days are omitted | month. In this each
copied to the 3 th . e th b ‘
other cells. The date and the series example, there are subsequen
. jumps from 34 only 30 days in two of | year.
increments ' . .
April to 6t April. | the months so 30t is
by one day at )
_ shown instead of 31st.
a time.
31-Mar-09 31-Mar-09 31-Mar-09 31-Mar-09 31-Mar-09 31-Mar-09
31-Mar-09 01-Apr-09 01-Apr-03 01-Apr-09 30-Apr-03 31-Mar-10
31-Mar-09 02-Apr-09 02-Apr-09 02-Apr-09 31-May-09 31-Mar-11
31-Mar-09 03-Apr-09 03-Apr-09 03-Apr-09 30-Jun-09 31-Mar-12
31-Mar-09 04-Apr-09 04-Apr-09 06-Apr-09 31-Jul-09 31-Mar-13
31-Mar-09 05-Apr-09 05-Apr-03 07-Apr-09 31-Aug-09 31-Mar-14
31-Mar-09 06-Apr-09 06-Apr-09 08-Apr-09 30-5ep-09 31-Mar-13
—— 8  Access fill options using right-click AutoFill.
Lopy Cells
Fill Series 1. Click again on cell F18 to make it the active cell.
::: \E:i;:zzt;i:n:img 2. AutoFill once more but, this time, hold down the right mouse
o button.
Fill Days
01-Jan-09 illveekdays When you release the mouse button you are presented with
02-Jan-09 AILATE the AutoFill options (see sidebar).
03-Jan-09 Fill Years
04-Jan-09 This method is preferred to the Smart Tag method because it is
05-Jan-09 faster (one click instead of two)!
06-Jan-05 Series.. . . .
07-Jan-09 — 9 Change back to Fill Series or Fill Days.

In this example Fill Series and Fill Days produce exactly the same
result.

10

Save your work as First Quarter Sales and Profit-11.
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Lesson 2-17: Speed up your
AutoFills and create a custom
fill series

In this lesson we’re going to learn some AutoFill techniques that will
massively speed up your efficient use of the AutoFill feature.

1 Open First Quarter Sales and Profit-11 (if it isn’t already
open).

2 Delete the contents of cells G18:G24.
3  Type 31-Mar-09 into cell G18.

A B C D E F ]

17

18 Monday 1 9 01-Jan-08 Adjusted 01-Jan-09 31-Mar-09
15 Tuesday 2 18 02-)an-08 Adjusted 02-Jan-09

20 Wednesday 3 27 03-Jan-08 Adjusted 03-lan-09

21 Thursday 4 36 04-Jan-08 Adjusted 04-lan-09

22 Friday 5 45 05-Jan-08 Adjusted 05-lan-09

23 Saturday 6 54 06-Jan-08 Adjusted 06-Jan-09

24 Sunday 7 63 07-)Jan-08 Adjusted 07-Jan-09

4 Double click the AutoFill handle to automatically fill cells
G19:G24.

This is a real master tip!

Hover over the AutoFill handle (the black spot at the bottom right
hand corner). When you are sure that you have the correct black
cross cursor shape, double click to automatically fill down.

Dl-Jan-DSI 31-Mar-os+L —Double-click 01-Jan-09 31-Mar-09
02-Jan-09 02-Jan-09 01-Apr-09
03-Jan-03 the black cross... | 03-1an-09 02-apr-0s
04-Jan-09 04-Jan-09 03-Apr-09
05-Jan-09 And be — 05-Jan-09 04-Apr-03
06-Jan-09 06-Jan-09 05-Apr-09
07-lan-09 amazed 07-Jan-03 06-Apr-09

5 Delete all of the dates from cells G19:G24 leaving only the
date 31-Mar-09 in cell G18.

6 Hold down the <Ctrl> key and AutoFill down as far as G24
by dragging the AutoFill handle down with the mouse.

Because you held the <Ctrl> key down AutoFill simply copies the
cell instead of creating a series of values.

First Quarter Sales and
Profit-11
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MNorth
South
East
West
MNorth
South
East
West

10
11

12

13

5 First Quarter Sales and Profit-10.xlsx - Microsoft Excel _ = *
Page Layout  Formulas Data Review  Wiew Developer  Add-Ins '@) - 2 X
I | ¥
B C D E F G K
1 9 01-lan-08 Adjusted 01-Jan-09 31-Mar-09
2 18 02-lan-08 Adjusted 02-)an-09 31-Mar-09
3 27 03-Jan-08 Adjusted 03-Jan-09 31-Mar-09
4 36 04-Jan-08 Adjusted 04-lan-09 31-Mar-09
5 45 05-Jan-08 Adjusted 05-Jan-09 31-Mar-09 | _
6 54 06-lan-08 Adjusted 06-lan-09 31-Mar-09 1
7 63 07-Jan-08 Adjusted 07-lan-09 31-Mar-09
eet? - Sheet3d ¥ | m |
M EE =S 0] (s

This is even faster than using the right-click method when you
want to prevent the date incrementing.

Click Office=>Excel Options—>Popular.

In the Popular category under Top options for working with
Excel click the gray Edit Custom Lists... button.

| Edit Custom Lists... |

The Custom Lists dialog appears.

Click in the List entries window and add four custom list
entries: North, South, East and West.

Custom Lists EX3)
Custom Lists
Custom lists: List entries:
«| |Morth -
Mon, Tue, Wed, Thu, Fri, Sat, S South
Monday, Tuesday, Wednesday, East
Jan, Feb, Mar, Apr, May, Jun, J West|

January, February, March, April

Press Enter to separate list entries,
Import list from cells: Import

OK l’ Cancel ]

Click the OK button.

Type North in any cell and AutoFill down.

As you AutoFill the custom list entries appear in the worksheet.

Delete the North, South, East, West... cells from the
worksheet.

Save your work as First Quarter Sales and Profit-12.
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Lesson 2-18: Use the zoom
control

Zooming is used to magnify or reduce the worksheet. If you have a lot of
rows in a worksheet and have good eyes you might want to zoom out
sometimes to see more of the worksheet on one screen.

1 Open First Quarter Sales and Profit-12 from your sample
files folder (if it isn’t already open).

2 Zoom in and out of a worksheet using the mouse wheel.
The fastest way to zoom a worksheet is by using the mouse.

Most mice these days have a wheel in the middle of the buttons. To
zoom using this wheel hold down the <Ctrl> key on the keyboard
and roll the wheel to zoom in and out.

3 Zoom in and out of a worksheet using the zoom control.
The zoom control is at the bottom right of your screen,

Click and drag on the zoom control slider to zoom in and out of
your worksheet. You can also zoom by clicking the plus and minus
buttons on either side of the Zoom control.

Click here to
Display the Zoom
dialog

Zoom out

Zoom in

Click and
drag

to zoom

| 100% (=) Y O

4  Select cells A3:D9.

We're going to use the zoom dialog to make this selection
completely fill the screen.

5 Click the left hand side of the zoom bar.
The zoom dialog is displayed.

First Quarter Sales and
Profit-12
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Session Two: Doing Useful Work with Excel

Select the Fit Selection option button and click the OK
button.

Zoom 2 ==

Magnification
~) 200%

| 100%

| 75%

| 50%

| 25%

ni

() Custom: | 206 | %

(0] 4 ] [ Cancel

The worksheet is zoomed so that the selected cells completely fill
the screen.

D =" T N
: r:)...e :Mm— .p,gm,;: Fommulss  Data  Review  View @ - = *é
A B C D X

1 Sales and Profit Report - First Quarter 2008

2

3] Jan Feb Mar

4 |New York 22,000 29,000 19,000

5 |Los Angeles 42,000 39,000 43,000

6 |London 18,000 20,000 22,000

7 |Paris 35,000 26,000 31,000

8 |Munich 12,000 15,000 13,000

9 |Sales 129,000 129,000 128,000

Zoom back to 100% using the Ribbon.

You'll probably find the zoom bar to be the quickest and most
convenient way to zoom, but the View Ribbon also has a Zoom
group containing three buttons:

"':i )

Joom 100% JFoomto
Selection

Joom

Use the 100% button to restore the screen to normal.

© 2017 The Smart Method Ltd
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Lesson 2-19: Print out a
worksheet

We aren’t going to explore every option for preparing and printing a
worksheet in this Basic Skills book. Printing is such a huge subject that a
whole session to it in the Essential Skills book in this series (in Session
Seven: Printing Your Work).

This lesson only aims to teach you the bare minimum skills you need to
put your work onto paper.

1 Open First Quarter Sales and Profit-12 from your sample
files folder (if it isn’t already open).

A B C D E F G
Sales and Profit Report - First Quarter 2008

1

2

3 Jan Feb Mar Average Maximum
4 Mew York 22,000 29,000 19,000 23,333 29,000
5 LosAngeles 42,000 39,000 43,000 41,333 43,000
6
7
8
9

London 18,000 20,000 22,000 20,000 22,000

Paris 35,000 26,000 31,000 30,667 35,000

Munich 12,000 15,000 13,000 13,333 15,000

Sales 129,000 129,000 128,000
10
11 Costs 83,000
12 |Profit 46,000
13 |10% Bonus 4,600
14
15 |USA Sales
16 European Sales
17
18 Monday 1 9 01-Jan-08 Adjusted 01-Jan-09 31-Mar-09
19 Tuesday 2 18 02-Jan-08 Adjusted 02-Jan-09 31-Mar-09
20 Wednesday 3 27 03-Jan-08 Adjusted 03-Jan-09 31-Mar-09
21 Thursday 4 36 04-Jan-08 Adjusted 04-Jan-09 31-Mar-09
22 |Friday 5 45 05-Jan-08 Adjusted 05-Jan-09 31-Mar-09
23 Saturday B 54 0B-Jan-08 Adjusted 06-Jan-09 31-Mar-09
24 |Sunday 7 63 07-Jan-08 Adjusted 07-Jan-09 31-Mar-09

L1

2 Click the Office button at the top left of the screen 913/.

Hover the mouse cursor over the Print button at the left of
the dialog.

4 Click Print Preview from the menu at the right hand side of
the dialog.

5 A preview of the printout is shown on screen:

First Quarter Sales and
Profit-12
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Session Two:

Doing Useful Work with Excel

lan
Mew York 22,000
Los Angeles 42,000
Londan 18,000
Paris 35,000
Munich 12,000
Sales 125,000
Costs 83,000
Profit 46,000
10% Bonus 4,600
USA Sales -
Eurppean Sales
Monday 1
Tuesday 2
Wednezday 3
Thursday 4
Friday 5
Saturday E
Sunday 7

Feb
29,000
39,000
20,000
26,000
15,000

129,000

13
27
36
45
54

Sales and Profit Report - First Quarter 2008

Mar Average  Maximum
19,000 23333 29000
43000 41333 43000
22000 20000 22,000
31,000 30667 35,000
13000 13333 15000

128,000
01-Jan-08 Adjusted  Ol-Jan-05
02-lan-08 Adjusted  02-lan-09
03-Jan-08 Adjusted  03-Jan-08
04-lan-08 Adjusted  O4-lan-08
05-lan-08 Adjusted  05-lan-09
06-lan-08 Adjusted  O&-lan-09
07-Jan-08 Adjusted  O07-lan-08

31-MarD3
31-Mar03
31-Mar03
31-Mar{s
31-Mar{s
31-Mar03
31-Mar{s

6 Click on the page to see the zoom feature working.

Each time you click on the page the page zooms in and out.

lfrh
7 Click the Print button “=¥ at the top left of the Print Preview

screen.

If you don’t see this icon at the top of the Print Preview window it
is because you have hidden the Ribbon. Unhide it by double-
clicking the Print Preview Ribbon tab.

The print options dialog appears:

Print -7 =]
Printer
Mame: & HP Laserlet 2420 PCL 6 [
Status: Idle = =
Type: HP LaserJet 2420 PCL & Lind Erigter
Where: DOT4_001
Comment:
[ Print to file
Print range Copies
@ Al Mumnber of copies: =
") Page{s) From: = To: =
Print what
| | 9 [P (3 e
) Selection _) Entire workbook
@ Active sheet(s) Table
|:| Ignare print areas
o ] (e

8  Click the OK button to print your work.

For this simple worksheet there’s no need to change any of the
options but you can probably figure out what most of them are for.
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10

11
12

Open a new workbook.
Use AutoFill to put the three months Jan, Feb, and Mar into cells A4:A6.

Using only the keyboard add the following data:

A B B D E
1 Profit Analysis
2
3 London  Paris Mew York Average
4 |lan 2,500 3,100 2,300
5 |Feb 2,200 2,700 2,600
6 Mar 2,100 2,600 2,800
7 |Total

Use AutoSum to compute London’s total profit for Jan/Feb/Mar in cell B7.
Use AutoSum to compute the average January profit in cell E4.

Use AutoFill to extend the London total in cell B7, to the Paris and New York totals in cells C7
and D7.

Use AutoFill to extend the January average profit in cell E4, to the February and March average
profits in cells E5 and E6.

Select all of Column A and all of Column E (at the same time) and bold face the values in them.

Select row 3 and row 7 (at the same time) and bold face the values in them.

A B E D E
1 | Profit Analysis
2
3 London  Paris Mew York Average
4 |lan 2,500 3,100 2,300 2,633
5 Feb 2,200 2,700 2,600 2,500
& |Mar 2,100 2,600 2,800 2,500
7 Total 6,800 8,400 7,700

Select cells B4:B6 and cells D4:D6 at the same time and then read the total London and New York
sales figure for Jan, Feb and March from the summary information displayed on the status bar.

Select cells B4:D6 and zoom the selection so that these cells fill the screen.

Save your work as Exercise2-End.

If you need help
slide the page to
the left

© 2017 The Smart Method Ltd
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These are the four questions that students find the most difficult to remember:

1. Hover over the
centre of cell B4 so that
you see the white
cross cursor shape.

02,500

2. Click and drag
down to cell Bé6.

3. Hold down the
<Ctrl> key.

4. Hover over cell D4
until you see the white
cross cursor shape.

5. Click and drag
down to cell Dé6.

This was covered in:
Lesson 2-7: Select non-
contiguous cell ranges
and view summary
information.

1. Click on the column
A header.

1A B

Profit Analysis

2. Hold down the
<Ctrl> key.

3. Click on the column
E header.

4. Click
Home->Font=>Bold.

Calibri

This was covered in:
Lesson 2-6: Select
adjacent and non-
adjacent rows and
columns.

1. Click in cell B7.

2. Click Home->Editing—>
Autosum (Q4).

éﬁj}tf'}.um - ? [ﬁ

o Clear~

Sort & Find &
Filter = Select =

Editing

OR

Click Home->Editing=>
Autosum—> Average (Q5).

x

[ £ AutoSum| =

sum

Averpge

Count My

3. Either press the <Enter> key
or click the Autosum button

again.

This was covered in: Lesson 2-3:
Use AutoSum to quickly calculate

totals.

1. Type Jan into cell
A4 and press the
<Enter> key.

2. Click cell A4 once
to make it the active
cell.

3. Hover the mouse
cursor over the
bottom right corner
of the cell until you
see the black cross
cursor shape.

Jan 1

4. Click and drag
down to cell A6.

This was covered
in: Lesson 2-14: Use
AutoFill for text and
numeric series.

If you have difficulty with the other questions, here are the lessons that cover the relevant skills:

1 Refer to: Lesson 2-2: Create a new workbook and view two workbooks at the same time.
3 Refer to: Lesson 2-1: Enter text and numbers into a worksheet.

6 Refer to: Lesson 2-15: Use AutoFill to adjust formulas.

7 Refer to: Lesson 2-15: Use AutoFill to adjust formulas.

9 Refer to: Lesson 2-6: Select adjacent and non-adjacent rows and columns.

11 Refer to: Lesson 2-18: Use the zoom control.

12 Refer to: Lesson 1-5: Save a workbook.

© 2017 The Smart Method Ltd
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Appendix A: Skills Covered
in the follow-on Essential
Skills Course

This free book has given you a flying start with Excel by giving you a
good grounding in Excel’s basic features. While you can now do some
useful work with Excel, you still need to expand your skillset to truly
describe yourself as a competent Excel user.

If you now progress to our Essential Skills course, you'll have Excel skills
that would impress any employer. Your Excel skills will be better than
most office workers (even those with many years of Excel experience).

Learn

Excel 2007
Basic Skills

With The Smart Method

Learn

Excel 2007
Essential Skills

With The Smart Method

Learn Excel in less
than five hours
with this
FREE book

Mike Smant

Mike Smart

This book ISBN: 978-0-9554599-2-4
(300 pages).

This appendix lists the lessons contained in the eight sessions that make
up the Essential Skills book.

Because you've already completed the Basic Skills book you'll be able to
skip the first two sessions.

Learn Excel 2007 Essential Skills with The Smart Method is available as both
a low-cost printed paper book (always in stock at Amazon) and as a PDF
e-Book (provided in the same format as this e-Book).

You can only obtain the Essential Skills e-Book from the
http://ExcelCentral.com web site (this is the publisher’s own web site:
The Smart Method Ltd).
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Essential skills course outline

Session 1 (a recap of the lessons in this basic
skills course)

Start Excel and check your program version

Maximize, minimize, re-size, move and close the Excel window
Understand the Application and Workbook windows
Download the sample files and open/navigate a workbook
Save a workbook

Pin a workbook and understand file organization

View, move, add, rename, delete and navigate worksheet tabs
Use the Ribbon

Understand Ribbon components

Customize the Quick Access Toolbar and preview the printout
Use the Mini Toolbar, Key Tips and keyboard shortcuts
Understand views

Use full screen view

Use the help system

Session 2 (a recap of the lessons in this basic
skills course)

B Enter text and numbers into a worksheet

B Create a new workbook and view two workbooks at the same time
B Use AutoSum to quickly calculate totals

B Select a range of cells and understand Smart Tags

B Enter data into a range and copy data across a range

B Select adjacent and non-adjacent rows and columns

B Select non-contiguous cell ranges and view summary information
B Re-size rows and columns

B AutoSelect a range of cells

B Use AutoSum to sum a non-contiguous range

B Use AutoSum to quickly calculate averages

B Create your own formulas

B Create functions using Formula AutoComplete

B Use AutoFill for text and numeric series

B Use AutoFill to adjust formulas

|

Use AutoFill Options



B Speed up your AutoFills and create a custom fill series
B Use the zoom control

B Print out a worksheet

Session 3 - Taking Your Skills To The Next Level

Insert and delete rows and columns

Use AutoComplete and fill data from adjacent cells
Cut, copy and paste

Cut, copy and paste using drag and drop

Use Paste Values

Increase/decrease decimal places displayed
Transpose a range

Use the multiple item clipboard

Use Undo and Redo

Insert, View and Print cell comments

Understand absolute, relative and mixed cell references
Create a template

Use a template

Freeze columns and rows

Split the window into multiple panes

Check spelling

Session 4 - Making Your Worksheets Look
Professional

Format dates

Understand date serial numbers

Format numbers using built-in number formats
Create custom number formats

Horizontally and Vertically align the contents of cells
Merge cells, wrap text and expand/collapse the formula bar
Understand themes

Use cell styles and change themes

Add color and gradient effects to cells

Add borders and lines

Create your own custom theme

Create your own custom cell styles

Use a master style book and merge styles



Use simple conditional formatting

Manage multiple conditional formats using the Rules Manager
Bring data alive with visualizations

Create a formula driven conditional format

Use the format painter

Rotate text

Session 5 - Charts and Graphics

B Create a simple chart with two clicks

Move, re-size, copy and delete a chart

Change the chart layout and add a data table

Format chart element fills and borders

Format 3-D elements and align text

Move, re-size, add and delete chart elements

Change a chart’s source data

Assign non-contiguous source data by click and drag
Change source data using the Select Data Source dialog tools
Chart non-contiguous source data by hiding rows and columns
Create a chart with numerical axis

Deal with empty data points

Add data labels to a chart

Highlight specific data points with color and annotations
Add gridlines and scale axes

Emphasize data by manipulating pie charts

Create a chart with two vertical axis

Create a combination chart containing different chart types
Add a trend line

Switch chart rows/columns

Add a gradient fill

Create your own chart templates

Session 6 - Multiple Worksheets and Workbooks

B View the same workbook in different windows

View two windows side by side and perform synchronous scrolling
Duplicate worksheets within a workbook

Move and copy worksheets from one workbook to another

Hide and unhide a worksheet



Create cross-worksheet formulas
Understand worksheet groups

Use find and replace

Session 7 - Printing Your Work

Print Preview and change paper orientation
Use Page Layout view to adjust margins

Use Page Setup to set margins more precisely and center the
worksheet

Set paper size and scale

Insert, delete and preview page breaks

Adjust page breaks using Page Break Preview

Add auto-headers and auto-footers and set starting page number
Add custom headers and footers

Specify different headers and footers for the first, odd and even pages
Print only part of a worksheet

Add row and column data labels and grid lines to printed output
Print several selected worksheets and change the page order

Suppress error messages in printouts






Appendix B: Skills Covered
in the follow-on Expert
Skills Course

This free book has given you a flying start with Excel by giving you a

good grounding in Excel’s basic features. While you can now do some
useful work with Excel, you still need to expand your skill set to truly
describe yourself as a competent Excel user.

Every Excel user can benefit from the Essential Skills book. After
completing this course, you will have an Excel skill level that would
impress any employer. Your Excel skills will be better than most office
workers (even those with many years of Excel experience).

Learn Learn Learn

Excel 2007 Excel 2007 . Excel 2007
Basic Skills Essential Skills Expert Skills

With The Smart Method With The Smart Method th The Smart Method

e’
Learn Excel in less
‘than five hours
with this E

FREE book

Not many Excel users will need to go further than Essential Skills in
expanding their skill set. Some users may have special requirements, or
simply a desire to understand absolutely every Excel feature. For such
users, we created our Expert Skills book that builds upon the skills
learned in the Essential Skills book.

The Expert Skills book teaches advanced Excel skills that are rarely
mastered by Excel users.

By the end of the book you'll be a true Excel expert. Your Excel skills will
be greater and broader than almost all other Excel users in the workplace.

This appendix lists the lessons contained in the eleven sessions that make
up the Expert Skills book.

Learn Excel 2007 Expert Skills with The Smart Method is available as both a
low-cost printed paper book (always in stock at Amazon) and as a PDF e-
Book (provided in the same format as this e-Book).

You can only obtain the Expert Skills e-Book from the
http://ExcelCentral.com web site (this is the publisher’s own web site:
The Smart Method Ltd).
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Expert skills course outline

Session 1 - Tables, and Ranges

Check your program and operating system version

Apply a simple filter to a range

Apply a top 10 and custom filter to a range

Apply an advanced filter with multiple OR criteria

Apply an advanced filter with complex criteria

Apply an advanced filter with function-driven criteria

Extract unique records using an advanced filter

Convert a range into a table and add a total row

Format a table using table styles and convert a table into a range
Create a custom table style

Sort a range or table by rows

Sort a range by columns

Sort a range or table by custom list

Name a table and create an automatic structured table reference
Create a manual structured table reference

Use special items in structured table references

Understand unqualified structured table references

Session 2 - Data Integrity, Subtotals and
Validations

Split fixed width data using Text to Columns

Split delimited data using Text to Columns

Automatically subtotal a range

Create nested subtotals

Consolidate data from multiple data ranges

Use data consolidation to generate quick subtotals from tables
Validate numerical data

Create user-friendly messages for validation errors

Create data entry input messages

Add a formula-driven date validation and a text length validation

Add a table-based dynamic list validation

Use a formula-driven custom validation to enforce complex
business rules

B Remove duplicate values from a range or table
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B Use a custom validation to add a unique constraint to a column

Session 3 - Advanced Functions

Understand precedence rules and use the Evaluate feature

Use common functions with Formula AutoComplete

Use the formula palette and the PMT function

Use the PV and FV functions to value investments

Use the IF logic function

Use the SUMIF and COUNTIF functions to create conditional totals
Understand date serial numbers

Understand common date functions

Use the DATEDIF function

Use date offsets to manage projects using the scheduling equation
Use the DATE function to offset days, months and years

Enter time values and perform basic time calculations

Perform time calculations that span midnight

Understand common time functions and convert date serial
numbers to decimal values

Use the TIME function to offset hours, minutes and seconds

Use the AND and OR functions to construct complex Boolean
criteria

Understand calculation options (manual and automatic)
Concatenate strings using the concatenation operator (&)

Use the TEXT function to format numerical values as strings

Extract text from fixed width strings using the LEFT, RIGHT and
MID functions

B Extract text from delimited strings using the FIND and LEN
functions

Use a VLOOKUP function for an exact lookup
Use an IFERROR function to suppress error messages

Use a VLOOKUP function for an inexact lookup

Session 4 - Using Names and the Formula
Auditing Tools

Automatically create single-cell range names
Manually create single cell range names and named constants
Use range names to make formulas more readable

Automatically create range names in two dimensions

Use intersection range names and the INDIRECT function



Create dynamic formula-based range names using the OFFSET
function

Create table based dynamic range names

Create two linked drop-down lists using range names
Understand the #NUM!, #DIV/0! and #NAME? error values
Understand the #VALUE!, #REF! and #NULL! error values
Understand background error checking and error checking rules
Manually check a worksheet for errors

Audit a formula by tracing precedents

Audit a formula by tracing dependents

Use the Watch Window to monitor cell values

Use Speak Cells to eliminate data entry errors

Session 5 - Pivot Tables

Create a one dimensional pivot table report from a table
Create a grouped pivot table report

Understand pivot table rows and columns

Use an external data source

Apply a simple filter and sort to a pivot table

Use report filter fields

Use report filter fields to automatically create multiple pages
Format a pivot table using PivotTable styles

Create a custom pivot table style

Understand pivot table report layouts

Add/remove subtotals and apply formatting to pivot table fields
Display multiple summations within a single pivot table
Add a calculated field to a pivot table

Add a calculated item to a pivot table

Group by text, date and numeric value ranges

Show row data by percentage of total rather than value
Create a pivot chart from a pivot table

Embed multiple pivot tables onto a worksheet

Session 6 - What If Analysis and Security

Create a single-input data table
Create a two-input data table
Define scenarios

Create a scenario summary report
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Use Goal Seek

Use Solver

Hide and unhide worksheets, columns and rows

Create custom views

Prevent unauthorized users from opening or modifying workbooks
Control the changes users can make to workbooks

Restrict the cells users are allowed to change

Allow different levels of access to a worksheet with multiple
passwords

Create a digital certificate
Add an invisible digital signature to a workbook

Add a visible digital signature to a workbook

Session 7 - Working with the Internet, Other
Applications and Workgroups

Publish a worksheet as a single web page
Publish multiple worksheets as a web site
Hyperlink to worksheets and ranges
Hyperlink to other workbooks and the Internet

Hyperlink to an e-mail address and enhance the browsing
experience

Execute a web query

Embed an Excel worksheet object into a Word document
Embed an Excel chart object into a Word document

Link an Excel worksheet to a Word document
Understand the three different ways to share a workbook
Share a workbook using the lock method

Share a workbook using the merge method

Share a workbook on a network

Accept and reject changes to shared workbooks

Session 8 - Forms and Macros

Add group box and option button controls to a worksheet form
Add a combo box control to a worksheet form

Set form control cell links

Connect result cells to a form

Add a check box control to a worksheet form

Use check box data in result cells



Add a temperature gauge chart to a form
Add a single input data table to a form
Improve form appearance and usability
Understand macros and VBA

Record a macro with absolute references
Understand macro security

Implement macro security

Record a macro with relative references
Use shapes to run macros

Run a macro from a button control
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Index

application window, 26
arrange all, 59
AutoComplete
formula entry using, 81
AutoFill
custom fill series, creating, 88
date series, examples of, 86
formulas, using to adjust, 84
smart tag options, using, 86
text and numeric series, creating with, 82
AutoFit rows and columns, 73
AutoSum, 60
AVERAGE functions, creating with, 76
MAX functions, creating with, 77
SUM a non contiguous range with, 74
AVERAGE function, 76

binary workbook format, 31

c_

cancel button, 56
cells
active cell, 70
deleting, 76
entering text into, 56
entering values into, 56
selecting a range of, 63
selecting all in a worksheet, 73
check box, 38
close button, 24
columns
making several the same size, 73
manually changing width of, 73
resizing automatically, 72
selecting, 66
selecting non contiguous, 66
confirm button, 56
currency
prefixes, 57
cursor shapes, explained, 63
custom lists, 89

dialog launcher, 39

documents. See also files
increasing the number of items in the recent
documents list, 32
organization of, 32
pinning, 32
downloading the sample files, 11, 28
drop-down list, 39

‘

editing cell contents, 56
Excel 97-2003 workbook format, 31
Excel workbook file format, 30

‘

files. See also workbooks
formats supported, 30
opening with earlier Excel versions, 31
setting the default file location, 33
formula bar
explanation of, 62
formulas
<F2> key to display range addressed by, 77
Autocomplete, creating with, 80
AutoFill, adjusting with, 84
AVERAGE function, creating using AutoSum,
76
formula bar, viewing in, 62
MAX function, creating using AutoSum, 77
mouse selection, creating with, 78
multiplication operator (*) using in, 79
SUM function, creating using AutoSum, 60
syntax box, understanding, 81
visual keyboard technique, creating with, 79
fractions,entering into cells, 57
full screen view, 46
functions
AVERAGE, 76
MAX, 77
SUM, 60, 74

‘

gallery, 38
GoTo Special, 71

‘

help system, 48
<F1> key, accessing with, 49



formula AutoComplete, accessing from within,
81

help button, accessing with, 48

Ribbon, accessing directly from, 49

key tips, 42
keyboard shortcuts
AutoSelect a range, 71
AutoSum, 60
bold, 43
close, 25
cycle through worksheets, 35
italic, 43
Ribbon, show/hide, 37
save, 30
select every cell in a worksheet, 72
underline, 43
workbook, create new, 58

macro enabled workbook format, 31
marching ants, 60
marquee, 60
MAX function, creating using AutoSum, 77
maximize button, 24
menus
rich, 39
shortcut (contextual), 43
standard, 38
mini toolbar
shortcut (contextual) menu, 43
using when entering text, 42
minimize button, 24
moving
the Excel window, 24
multiplication operator (*), 79

name box, 28
normal view, 44
number sign (¥), 72

page break preview view, 44
page layout view, 44
pound sign (#), 72
printing
page break preview view, 44

previewing on screen, 40

quick access toolbar
adding commands to, 40
adding seperators to, 40
deleting commands from, 40
quotations
Aristotle, 38
Confucius, 19
Euripides, 21
George Gershwin, 72
Melanie (M. Safka), 36
Robert Collier, 24
Winston Churchill, 18

ranges
AutoSelect, selecting automatically with, 70
copying data across, 64
entering data into, 64
non contiguous, selecting, 68
select all button, to select a range containing
every cell in a worksheet, 73
selecting, 62
selecting visually for formulas with the mouse,
78
restore down button, 24
ribbon
benefits of wide screen with, 36
command groups on, 38
contextual tabs, explanation of, 37
controls on, 38
font panel controls, explanation of, 37
overview, 36
showing and hiding (minimizing), 37
rows
making several the same size, 73
manually setting height of, 73
resizing automatically, 72
selecting, 66
selecting non contiguous, 66

sample files
downloading, 11, 28
save, 30
selecting cells, 62
smart tag
explained, 62
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options, 86
split button, 38
start Excel, 22
SUM function
creating manually using formula
AutoComplete, 80
creating using AutoSum, 60
switch windows, 59

‘

tabs. See worksheets
the smart method
informal summary, 17
learning by participation, 19
session objectives, 17
two facing pages rule, 18
title bar, 58

‘

values
currency prefixes, using with, 57
entering into cells, 56
fractions, entering into cells, 57
negative numbers, entering into cells, 57
version, checking, 22

]

windows

application and workbook windows,
explanation of, 26
arrange all, using to automatically size, 59
closing, 24
moving, 24
resizing, 24
restoring down, 24
switching to view a different workbook, 59
workbook window, 26
workbooks. See also files
creating new, 58
opening, 28
saving, 30
switching between open workbooks, 59
viewing two at the same time, 58
views, 44
worksheets
adding, 34
changing tab colors, 35
chart worksheets, explanation of, 34
deleting, 34
maximum number of rows and columns in, 28
navigating, 28, 34
renaming, 34

zoom control, 90



Moving to the next level
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Excel 2007
Essential Skills

With The Smart Method
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Excel 2007
Expert Skills
With The Smart Method
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Essential

The next book/e-book in this series (Essential Skills)
builds upon the basic skills you’ve already learned.

When you have completed this book/e-book you will have excellent
Excel skills, good enough to impress any employer, and your Excel
skills will be better than most office workers (even those with many
years of experience).

You'll be able to create beautifully laid-out worksheets that will
really impress and will have completely mastered all of Excel’s
charting features.

The paper printed book is always in stock at Amazon.

The e-book is published in unlocked PDF format (just like this basic-
skills e-book) and is only available from http:///ExcelCentral.com
(this is the publisher’s own web site).

If you purchase this book as an e-book, you'll also have access to
videos of each lesson at: http:///ExcelCentral.com.

The last book in the series (Expert skills) covers only
the most advanced Excel features.

This book will give you advanced Excel skills that are rarely
mastered by the average user. By the end of the book you'll be a true
Excel expert, able to use all of the power available from the world’s
most powerful business tool.

Your Excel skills will be greater and broader than almost all other
Excel users in the workplace.

The paper printed book is always in stock at Amazon.

The e-book is published in unlocked PDF format (just like this basic-
skills e-book) and is only available from http://ExcelCentral.com (this
is the publisher’s own web site).

If you purchase this book as an e-book, you'll also have access to
videos of each lesson at: http://ExcelCentral.com.
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The Smart Method’s e-book/video
packages

You are currently using Excel 2007, but it is likely that you will update to Excel 2016 in the near future. If you
register for the Excel 2007 e-books and videos you will also receive the e-books and videos for Excel 2010,
2013, 2016 and 2016 for Apple Mac, as well as the next two editions of our Excel 2016 e-book (and Excel 2016
e-book for Apple Mac).

This means that our e-book packages are always the most up-to-date resources available, while also allowing
for the use of older versions.

Why we recommend the e-book package for Excel 2016

Excel 2013
Leam

Excel 2013
Essential Skills
Excel 2_01 6" _" ! With The Smart Method
Essential Skills .. k.. 1

With The '

Learn

Excel 2013

Essential Skills
With The Smart Method

Video Course
EEEEEN

Excel 2010
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Learn

Excel 2010

Essential Skills
With The Smart Method

Video Course

Excel 2007
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Excel 2007
Essential Skills
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Learn

Excel 2007

Essential Skills
4 With The Smart Method

Video Course
EEEEEN

With Excel 2007, 2010, 2013 and 2016, we became used to an Excel product that only had a feature update
every three years.

Many have speculated that Excel 2016 may be the last Excel version ever released. That’s because a new
version of Excel 2016 (now often referred to by the new name: Excel 365) is now released every six months
(in January and July).

You could think of these new versions as Excel (Jan 2018), Excel (July 2018), Excel (Jan 2019) etc.

When you purchase an Excel 2016 e-Book package from The Smart Method you don’t just get the current
version of the e-book. You also get the right to use (both online and offline) the next two editions of the e-
Book as well. That means that if (for example) you purchased an e-book in February 2018 (covering the Jan
18 release), you'd also have access to the Jul 2018 edition and Jan 2019 edition of the e-book at no extra cost.

E-book purchasers also get the right to view all lessons and videos in legacy versions of Excel (Excel 2007,
2010 and 2013). All e-books are supplied as unlocked PDF files and you have the right to print a paper copy
for your own personal use if required.

Our courses are also available as low-cost paper printed books

Our books are printed using the very latest digital technology. As well as providing better print quality than
the old-fashioned ink presses, it also means that we can instantly print in small batches. Traditional printers
used to print at least 15,000 books at a time — stock that often sat in a warehouse for years.

Because of the streamlined printing process, we aim to have a new edition of our paper printed book in stock
(and available for purchase via Amazon) on (or slightly before) the release date of each new Excel version (in
January and July of each year).



How you can use our training materials

Use our paper-printed books to teach all Excel versions.

You can print this Basic Skills book yourself for free and use it to teach your own Excel classes. We can also
directly and rapidly supply the latest edition of our paper-printed books, at educational discount prices, to
Excel instructors, book stores, corporate clients, schools, colleges and universities from our warehouses in
the USA (also serving Canada), UK (also serving Europe) and Australia (also serving New Zealand).

Our Excel 2007 Essential Skills and Excel 2007 Expert Skills books are available as printed paper books (and as
PDF printable e-books). We also have books (and PDF printable e-books) to teach Excel 2016 for both
Windows and Apple Mac, and for the legacy versions of Excel (Excel 2013 and 2010). This means that you’ll
be able to teach Excel classes whatever version of Excel your client, students or employees are using.

Mac Titles Windows Titles
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Excel 2013
Essential Skills
With The Smart Method

Learn

Excel 2013
Expert Skills

With The Smart Method

Learn

Excel 2016 *""

Essential Skills
With The Smart Method

Learn Leam
Excel 2016 &:x* Excel 2016 >~
Essential Skills Expert Skills Expert Skills
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978-1-909253-11-7 978-1-909253-12-4 978-1-909253-09-4 978-1-909253-06-3
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Excel 2007
Essential Skills
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Excel 2007
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Excel 2010
Expert Skills

With The Smart Method
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Excel 2010
Essential Skills

978-0-9554599-8-6 978-0-9554599-7-9 978-0-9554599-3-1 978-0-9554599-2-4

You can also quote the ISBN numbers shown above to any book retailer or wholesaler. All major distributors
(in every country of the world) should have the latest edition of our books in stock for immediate delivery.
They are also always in stock at Amazon (who normally offer a next-day or even same-day delivery option).

Place a direct order for 5+ books (or e-books) for wholesale prices and
free delivery

To place a publisher-direct order you only need to order five books or more (you can mix titles if you wish).
When you order directly from the publisher you are always assured of receiving the very latest updated
edition and version of our books.

You can also purchase e-book/video package activation codes for students/employees in your organization, at
discount prices, to empower them with cutting-edge Excel skills. An activation code enables the
student/employee to register and access our entire catalogue of printable PDF e-books and video tutorials
without payment.

To view wholesale prices (for both e-book/video packages and paper printed books), go to the
http://ExcelCentral.com web site and select Pricing from the main menu.
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Obtain a fast solution to any Excel issue
using our support forum

Sometimes the correct solution to a specific Excel-related problem is not immediately apparent. Our online
support forum enables you to ask any Excel-related question. One of our staff members will solve the
problem.

The problem with most Excel forums

There are many forums on the Internet where members of the public try to answer each other’s questions to
help to solve Excel problems. If you've ever used such a forum you will know the problems that this creates:

B The Internet can become a mine of misinformation as good-natured contributors provide incorrect or
misleading information.

Questions are sometimes not answered at all, or are answered weeks after asking a question.

Topics tend to rapidly drift “off topic” as contributors answer questions that were not asked by the
original poster.

B Contributors often post VBA program code in their answers (almost always the wrong approach to
solving an Excel-related problem).

B Answers are often found that are many years out of date (referring to products such as Excel 2003 that
bear little resemblance to contemporary versions of Excel).

How the ExcelCentral.com forum is different

Our forum is the same as others found on the web in that Excel users ask for solutions to real-world business
problems. Our difference is that the answers are written by paid staff members who have many years of
Excel experience. This presents the following advantages:

B The answers you see will always be correct and represent the best-practice way of solving a problem.
B Most problems only require a single answer as the problem is usually solved at once.

B VBA code is never used in forum answers as we solve Excel problems using Excel’s own features rather
than by using program code.

B Every time that Excel is updated we re-visit older questions and update them so that the answers match
the latest Excel version.

B Questions are sometimes answered almost immediately, but are always answered within 24 hours.

You can read answers to questions that have previously been posed, completely free of charge. You must be
a registered user to post any questions. Visit:

http://forums.ExcelCentral.com/ ... for an insight into how it all works.
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